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Document Contents

The document is a collection of several independent manuals.

Depending on your application, some of the manuals in this document may not apply to your
ZonicBook System.

The manuals are presented in the following order:

• ZonicBook Getting Started User’s Manual
Describes hardware and software installation pertaining to the ZonicBook system.
This introductory manual applies to all ZonicBook systems and should be read before reading any
of the following companion manuals. – p/n 1086-0920

• eZ-TOMAS User’s  Manual
Discusses the Online Monitoring and Analysis software known as eZ-TOMAS
(Temporary Online Monitoring and Analysis Software).  eZ-TOMAS is designed to collect
vibration and process data from rotating machinery.  The “T” (Temporary) in eZ-TOMAS
indicates that this monitoring system can be moved from one machine to another.
This software is project oriented, easy to setup, and run. – p/n 1086-0923

• eZ-NDT/RI User’s Manual
Discusses the eZ-NDT/RI programs.  eZ-NDT/RI is a Non-Destructive Testing program that uses
Resonant Inspection to determine the quality of an object or structure.  eZ-NDT/RI can be used for
spot-checking, or for inline production testing. – p/n 1086-0924

• eZ-Balance User’s Manual
Pertains to the eZ-Balance multi-plane, multi-sensor balancing application.  eZ-Balance is used in
ZonicBook applications for automated data acquisition.  eZ-Balance is also available as a
stand-a-lone program. – p/n 1086-0925

• eZ-Analyst User’s Manual     See the reference note below.

CAUTION

Using this equipment in ways other than described in this manual can cause personal
injury or equipment damage.  Before setting up and using your equipment,  you
should read all documentation that covers your system.  Pay special attention to
Warnings and Cautions.

Reference Note:
For information regarding eZ-Analyst, refer to the separate document, entitled
eZ-Analyst Software Guide for Acquiring, Analyzing, and Recording Data, p/n
1086-0922.  The eZ-Analyst software package provides control features for ZonicBook and
WaveBook Data Acquisition systems and includes full-featured FFTanalysis.  eZ-Analyst is
ideal for Modal Analysis, Operating Deflection Shape Analysis, Machine Tool Analysis, and
general time and frequency applications where the test article is in a constant response mode.
The application’s record feature can capture gapless, alias-free data [up to the selected
bandwidth] and stream it directly to your storage media. Live data can be viewed on a
channel-by-channel basis.
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Warranty Information
Your IOtech warranty is as stated on the product warranty card.  You may contact IOtech by phone,
fax machine, or e-mail in regard to warranty-related issues.

Phone: (440) 439-4091,  fax:  (440) 439-4093,  e-mail: sales@iotech.com

Limitation of Liability
IOtech, Inc. cannot be held liable for any damages resulting from the use or misuse of this product.

Copyright, Trademark, and Licensing Notice
All IOtech documentation, software, and hardware are copyright with all rights reserved.  No part of this product may be
copied, reproduced or transmitted by any mechanical, photographic, electronic, or other method without IOtech’s prior written
consent.  IOtech product names are trademarked; other product names, as applicable, are trademarks of their respective
holders.  All supplied IOtech software (including miscellaneous support files, drivers, and sample programs) may only be used
on one installation.  You may make archival backup copies.

FCC Statement
IOtech devices emit radio frequency energy in levels compliant with Federal Communications Commission rules (Part 15)
for Class A devices.  If necessary, refer to the FCC booklet How To Identify and Resolve Radio-TV Interference Problems
(stock # 004-000-00345-4) which is available from the U.S. Government Printing Office, Washington, D.C.  20402.

CE Notice
Many IOtech products carry the CE marker indicating they comply with the safety and emissions standards of the
European Community.  As applicable, we ship these products with a Declaration of Conformity stating which
specifications and operating conditions apply.

Warnings, Cautions, Notes, and Tips
Refer all service to qualified personnel.  This warns of possible personal injury or equipment damage under noted
conditions.  Follow all safety standards of professional practice and the recommendations in this manual.  Using this
equipment in ways other than described in this manual can present serious safety hazards or cause equipment damage.

This warning symbol is used in this manual or on the equipment to warn of possible injury or death from electrical
shock under noted conditions.

Use proper ESD handling guidelines when handling equipment or components sensitive to damage from electrostatic
discharge.  Proper handling guidelines include the use of grounded anti-static mats and wrist straps, ESD-protective bags
and cartons, and related procedures.

This symbol indicates the message is important, but is not of a Warning or Caution category.  These notes can be of
great benefit to the user, and should be read.

In this manual, the book symbol always precedes the words “Reference Note.”  This type of note identifies the location
of additional information that may prove helpful.  References may be made to other chapters or other documentation.

Tips provide advice that may save time during a procedure, or help to clarify an issue.  Tips may include additional
reference.

Specifications and Calibration

Specifications are subject to change without notice.  Significant changes will be addressed in an addendum or revision to the
manual.  As applicable, IOtech calibrates its hardware to published specifications.  Periodic hardware calibration is not covered
under the warranty and must be performed by qualified personnel as specified in this manual.  Improper calibration procedures
may void the warranty.

Quality Notice

IOtech has maintained ISO 9001 certification since 1996.  Prior to shipment, we thoroughly test our products and review
our documentation to assure the highest quality in all aspects.  In a spirit of continuous improvement, IOtech welcomes
your suggestions.

mailto:sales@iotech.com
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Introduction

ZonicBook Hardware
ZonicBook 4, 8, and 16-channel data acquisition modules are built to take advantage of PCs running under
Windows operating systems.

Inside each ZonicBook is an analog to digital converter with anti-aliasing filters for each channel.
Synchronous sampling of all channels ensures accurate phase relationships and the correlation of data.

The interface between the ZonicBook and the host PC is a type III PCMCIA card, which we will refer to as
a “DSP Card” (Digital Signal Processing Card).  A proprietary chip set on the card provides the digital
signal processing of both time history and Fast Fourier Transform (FFT) analysis data.  A four-megabyte
buffer is used to ensure gap-less data, independent of available processor memory.

Machine conditions and analysis solutions can be shared instantaneously with associates, providing that
ZonicBook’s host PC is connected to an Ethernet LAN, file server, internet, or intranet.

ZonicBook Software
The ZonicBook is operated via Graphical User Interface (GUI).  Prior to using a ZonicBook system, it is
essential that:

• the DSP program has been loaded into the DSP Card
• the ZonicBook is initialized
• system communications are working properly

Depending on your application, one or more of the following software programs can be used for interactive
communication with your ZonicBook system.
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eZ-NDT/RI:  eZ-NDT/RI is a Non-Destructive Testing program that uses resonance to determine the
quality of the test object.  A ZonicBook system with eZ-NDT/RI can be place in a production line to
perform the non-destructive resonant inspections during the production run.

eZ-TOMAS (Temporary Online Monitoring and Analysis Software):  With this software, a ZonicBook
can monitor and analyze vibrations from rotating machinery.  Note that these ZonicBook systems can be
moved from one machine to another with relative ease.

eZ-Balance: is a multi-plane, multi-sensor balancing application that can be used with the ZonicBook for
automated data acquisition.

eZ-Analyst:  This software package provides control features for ZonicBook and WaveBook Data
Acquisition systems, as well as full-featured Fast Fourier Transform (FFT) analysis.  It’s ideal for Modal
Analysis, Operating Deflection Shape Analysis, Machine Tool Analysis, and general time and frequency
applications where the test article is in a constant response mode.  eZ-Analyst captures gapless, alias-free
data (up to the selected bandwidth) and streams it directly to the storage media.  Live data can be viewed on
a channel-by-channel basis.  eZ-Analyst is detailed in an independent document, p/n 1086-0922.

System Requirements

Before setting up the hardware or installing the software, verify that you have the following items.

❑ ZonicBook Data Acquisition Module

❑ ZonicBook DSP-Card

❑ Universal Power Supply with cord (U.S.)

❑ Data Acquisition CD

❑ Passwords for purchased software packages

The Passwords for your purchased software accompany your CD.  Keep your passwords
in a safe place.  You will need to enter them during software installation.

In addition to the previous checklist items, verify that your computer meets the following
minimum requirements.

❑ Intel™, Pentium 90 MHz or equivalent

❑ a slot for a Type III PCMCIA Card

❑ 32 MB Memory

❑ 100 MB Hard Disk space

❑ Monitor: SVGA, 800 x 600 resolution

❑ Microsoft® Windows 95/ 98/ Me/ NT/ 2000/ XP Operating System.

Reference Note:
Adobe Acrobat PDF versions of documents pertaining to ZonicBook are automatically
installed onto your PC’s hard-drive as a part of product support at the time of software
installation.  The default location is the Program Files directory, which can be accessed via
the Windows Desktop Start Menu.
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Software Installation

Be sure to install the software prior to performing the hardware installation.

If you purchased software, associated passwords will accompany your installation CD.
If this is the case, keep your passwords in a safe place.  You will need to enter them once,
during an actual run of the applicable software package.

Software Installation for Windows 98/Me/2000/XP/NT
1. Start Windows.

2. Close all running applications.

3. Insert the Data Acquisition CD into your CD-ROM drive and wait for the CD to auto-run.

If the CD does not start on its own:

(a) click the desktop’s <Start> button
(b) choose the Run command
(c) select the CD-ROM drive, then select the setup.exe file.
(d) click <OK>.

A Master Setup Screen will appear, similar to the one shown in the
following figure.

Data Acquisition Software, Master Setup Screen
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4. Select the following:
ZonicBook Support.
Acrobat Reader
Post Acquisition Data Analysis Program
Applicable Software Package*

*The following software applications can be selected after ZonicBook Support is checked:

(a) eZ-Balance

(b) eZ-NDT/RI

(c) eZ-Rotate

(d) eZ-TOMAS

(e) eZ-Analyst

Note that after selecting eZ-Analyst you will be prompted to select ZonicBook
or WaveBook.  eZ-Analyst users should refer to the eZ-Analyst Software Guide,
p/n 1086-0922, for details pertaining to the use of eZ-Analyst.

If you purchased software, associated passwords will accompany your installation CD.
If this is the case, keep your passwords in a safe place.  You will need to enter them
once, during an actual run of the applicable software program.

5. Follow the on-screen directions to install your software.

6. Install other ZonicBook software programs, if applicable.

A Special Note for Windows NT Users

If your PC is using Windows NT, perform the following after you have installed the software.

1. Verify that you are logged on with Administrator capabilities.

2. Verify IRQ and I/O Port availability.  This is done as follows:
(a) From the Start menu, navigate as follows:

Program ⇒⇒⇒⇒ Windows NT Diagnostics ⇒⇒⇒⇒ Resources
(b) Verify and write down the I/O Port Address; for example: 0110-011F
(c) Verify and write down available IRQs; for example: 9, 10, 11.

3. Open the Control Panel.

4. Double-click the CACDSP icon.  This opens the CAC API Configuration Utility window.

5. In the data entry box, enter the I/O Port Address [from step 8b].
Typically the I/O Port is either 0x0110 or 0x0120.

6. In the data entry box, enter an available interrupt (IRQ) for your system [from step 8c].
Typically this is 10 or 11.

7. Click the DSP Tab.

8. Select PCMCIA.

9. Click the <ADD> button.

Note:   For Windows NT operating systems, the I/O Port Address and IRQ values do not
show up in the menus after you close the window.  They are; however, stored in
memory.

10. Click <OK.>

11. Restart your computer.
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Your computer is now ready to run ZonicBook software and communicate with the
ZonicBook module.

If the DSP-Card does not respond in Windows NT, try the following:

1. From the desktop, open the Control Panel.  This is done by navigating as follows:

Start ⇒⇒⇒⇒ Settings ⇒⇒⇒⇒ Control Panel ⇒⇒⇒⇒ System ⇒⇒⇒⇒ Device Manager ⇒⇒⇒⇒ CACDSP

Note: “CACDSP” represents the DSP-Card device

2. Double-click the “CACDSP” (DSP-Card) device.

3. Click the <Start> button.  This starts the DSP-Card without the need to reboot the computer.

4. To enable or disable the DSP-Card, click the <Startup> button, then click the <Enable> or the
<Disable> button as applicable.

5. Click the <HW Profiles> button.

6. If the Startup method is not set to “Automatic,” set the DSP-Card for “Automatic” startup.

Hardware Setup and DSP-Card Installation    (All Windows Systems)

Reference Note:
If you have not already set up your hardware and installed your DSP-card, refer
to your ZonicBook User’s Manual (p/n 1086-0901), and do so at this time.

Verifying DSP-Card Installation
You can use the Window’s Device Manager to verify that the DSP-card has been properly installed.
The steps for this method are as follows.

1. From the Windows Desktop, click <Start>.

2. Click Settings.

3. Click Control Panel.

4. Click the System icon.

5. Click the “Device Manager” tab.

6. Locate one of the following nodes, as applicable to you Window’s operating system.

• Windows 98 and Windows Me users should locate a node called D32DSP.

• Windows 2000, Windows XP, Windows NT users should locate a node
called CACDSP.

7. Expand that node by clicking on the “+” symbol.

At this point you should see a screen similar to one of the following, depending on which
operating system your PC is using.

DSP Verification, Windows 98 and Windows Me
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DSP Verification, Windows 2000

DSP Verification, Windows XP

Note: A screen image is not shown for Windows NT.  However, Windows NT makes
use of a CACDSP node, as do Windows 2000 and Windows NT.

Reference Note:
After your software is installed you can setup your ZonicBook Data Acquisition Module and
connect it to the host computer.  Instructions for Hardware Setup begin on page 7.
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Hardware Setup

Configuring Channels via DIP-Switches
ZonicBook channel configuration is determined by DIP-switch settings.  The default setting is “Single
Ended, A.C. Coupled ICP (Off).”  Possible settings are illustrated below.

CAUTIONCAUTIONCAUTIONCAUTION
Each channel must have its associated DIP-switch properly set to achieve the desired
configuration, as determined by your application.  Improper settings can damage
your equipment, and will produce erroneous measurements.

To set the switches:

1. Ensure the ZonicBook is disconnected from power, the PC, and all signal lines.

2. Remove ZonicBook’s bottom cover plate.

3. Set each channel’s DIP-switch according to the desired configuration.
Refer to other documentation if needed.

4. Replace the bottom cover plate.

5. For 16-Channel ZonicBook’s only.
(a) After setting the DIP-switches for Channels 1 through 8,

replace the bottom cover plate.
(b) Remove the top cover plate.
(c) Set the DIP-switches for Channels 9 through 16.
(d) Replace the top cover plate.

Channel DIP-Switch Settings

Reference Note:
For convenience, ZonicBook’s bottom cover plate includes illustrations of
the DIP-switch settings.

Default
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Connecting and Powering a ZonicBook System

It is relatively easy to connect a ZonicBook system, and to supply power to it.  The steps are as follows:

1. Insert the DSP-Card into your computer’s PCMCIA slot.

2. Connect the DSP cable to the DSP-Card.

3. Connect the ZonicBook to the DSP-cable.

4. Connect the Power Supply to the ZonicBook.

5. Connect the Power Cord to the Power Supply.

6. Connect the Power Supply to an appropriate power source.

7. Connect the computer to power.

8. Turn on the computer.

9. Turn on the ZonicBook.
A green Power ON LED (on the face of the unit) will light.

8-Chanel ZonicBook System

Cap unused BNCs to reduce extraneous noise, and to keep the connectors free of
dust and other debris.

DSP-Card with Cable
(DSP-Card, not shown, is in NoteBook’s
PCMCIA Slot)

ZonicBook
Data Acquisition Module Power Supply

Notebook PC
with PCMCIA Slot

Power Cord



ZonicBook 04-29-02 Getting Started, pg.  9

Starting the ZonicBook
The ZonicBook system is ready for use once the tasks in the following checklist have been completed.

❑ Software Installed (pg. 3)

❑ Channel DIP-switches Set (pg. 7)

❑ Hardware Connected and Powered ON (pg. 8)

❑ Signal Lines Connected to ZonicBook BNC Connectors for Channel Input

❑ Unused BNC Connectors Capped

To start the ZonicBook system:

1. On the Start Menu, select Programs.

2. Select ZonicBook.

3. Select the applicable ZonicBook software, e.g., eZ-Analyst, eZ-Balance.

Reference Note:  Refer to the applicable document module in regard to software specifics.
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ZonicBook Specifications

General Specifications
Environment

Operating: 0° to 50°C, 0° to 95% RH, non-condensing
(ZonicBook only)

Storage: -20° to 70°C

Power Consumption: 8.5 watts max with +12 VDC power
supply

Input Power Range: 9 to +15 VDC

Dimensions: 279 mm W x 216 mm D x 35 mm H
(11” x 8.5” x 1.375”)

Weight: 1.32 kg (2.9 lbs)

PC-Card (included): Requires one type III slot

PC-Card to ZonicBook Cable (included): 30 in.

Analog Inputs
Input Channels: 4, 8, or 16*

Input Connector: BNC

A/D: One 16-bit Sigma Delta converter per channel

Sampling: All input channels are sampled simultaneously,
up to 51.2 kHz max per channel

Digital Decimation Filter: 92 dB stop-band attenuation

Dynamic Range: >80 dB typ

Amplitude Flatness: 1 dB typ

Bipolar Ranges: 25 mV to 25V full scale in 1.5 dB steps

Maximum Overvoltage: ±80 VDC

Input Bandwidth:
4- and 8-Channel ZonicBook:  DC to 20 kHz
16-Channel ZonicBook:           DC to 10 kHz

Input Coupling: AC, DC; switch selectable, per channel

AC Coupling: 1.6 Hz; -3 dB point

ICP Voltage (@ 4 mA): 24V ±.5V (no load), 20V bias max

Input Impedance

Single-Ended: 1M Ohm in parallel with 30 Pf

Differential: 2M Ohm in parallel with 30 Pf

Accuracy: 25 mV to 25V; ±2% (±0.2 dB)

Channel Match: +1 dB amplitude, +1° phase

Input Noise:  ≤ ±3 LSB (RMS)

Total Harmonic Distortion: -62 dB typ

Signal to Noise and Distortion: -60 dB typ

Cross Talk: < 75 dB max; relative to full scale

Anti-Alias Filters: 80 dB alias rejection

Output Characteristics
Number of Channels: 1 BNC output per ZonicBook

Output Frequency Range: 2 kHz

Dynamic Range: 80 dB typ

Frequency Resolution: 0.001 Hz

Frequency Accuracy: 100 ppm

Amplitude Accuracy: 2.0% @ 1V; up to 1 kHz

Maximum Amplitude: 2.8V peak-peak

DAC Resolution: 16-bit Sigma Delta

Processing Characteristics
Analysis Frequency: 10 Hz to 20 kHz for 4- or 8-channel

ZonicBooks; 10 Hz to 10 KHz for 16-channel ZonicBook;
All input channels are sampled synchronous; Analysis
Rate is set for all channels

Blocksize: 128 to 16,384 data samples per block of data
(in powers of 2)

FFT Windows

Response Channels: None, Hanning, Flat Top,
Exponential, 3 Term Blackman Harris

Force Channels: None, Rectangular, Cosine Taper

Integration/Differentiation (in frequency domain):
Single and Double Differentiation; Single and Double
Integration

Averaging: Linear, Exponential, Negative, Peak Hold,
Time Synchronous

Acquisition Triggers: Free Run

User-Programmed Trigger: Level and Slope,
Time and Date, Pre or Post data trigger delay

Octave Filter: A, B, and C Weighting

Display Types: Time, Trend, Auto Spectrum, Cross
Spectrum, Spectrum, FRF, PSD, Transfer Function, 1/3
Octave, Full Octave, Coherence

Transfer Function Types: Inertance, Mobility,
Compliance, Apparent Mass, Impedance, Dynamic
Stiffness

Octave Types: 1/3, Full
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Introduction 1

What is eZ-TOMAS …… 1
Start eZ-TOMAS …… 2
Connecting Signals …… 2
Order of Operation …… 3

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

What is eZ-TOMAS?
eZ-TOMAS (Temporary Online Monitoring and Analysis Software) is designed to collect vibration and
process data from rotating machinery.

eZ-TOMAS can simultaneously monitor, acquire, store, and display data from the ZonicBook FFT
analyzer.  Typically, these signals are associated with a specific machine train.  The analog inputs can be
any combination of Proximity, Velocity, Accelerometer, Tach, or DC proportional voltage signals.
Up to three tach signals are supported.

The data acquired by eZ-TOMAS and the supporting configuration information are stored in files defined
by you. This allows you to move eZ-TOMAS from machine to machine.  The acquired data is stored based
on event changes defined by you.  Defined events include time, overall, and rotating speed.

Acquisition, instrumentation, and storage configuration parameters are also definable.  These parameters
are stored over time.  Configuration changes do not invalidate previously acquired data.

A basic graphical User Interface (UI) is provided.  The UI consists of 8 instrument gauges.  The gauge
display can include any one of 10 spectral amplitudes or frequencies of interest.  You can interactively
display data in a variety of formats, including:  Spectrum, Orbit, Polar, Time, Bode, Cascade/Waterfall and
Strip Chart.
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Start eZ-TOMAS
To run eZ-TOMAS, double-click the eZ-TOMAS icon or use your Windows desktop Start button
to navigate to the program file.

The first time you start eZ-TOMAS you will be prompted for your name, your company name, and
a password.  This password is the software key that will activate eZ-TOMAS for every day operations.

Registration Form

If you are loading your software from a CD the password accompanies the CD.  If you downloaded your
software from the website, your password will be emailed to you within one business day.

You will next be prompted to set up your project’s security password.  When you click the <Save> button
the Password Confirm window opens.  Retype your security password and click the <Confirm> button.

Password Form

After your password is accepted, you are returned to the Main window.

Connecting Signals
Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

Connect your analog signals to the ZonicBook’s BNC inputs. Typically, proximity and DC proportional
signals should be DC coupled; and Accelerometer, Velocity, and Tach signals should be AC coupled.

Prox: SE(single ended) DC ICP off
Accel/Vel: SE AC ICP  on
Tach: SE AC ICP off
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Order of Operation

Start eZ-TOMAS
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Start a New Project 2

Configure the Project …… 6
Configure the ZonicBook …… 6

Start Monitoring …… 6
View Spectral Bands …… 7
Plot Data …… 7

Multiple Plots …… 7

Generate Limits …… 8
Limit Status Color Code …… 10

Continue Monitoring …… 10
Are Alarms acceptable? …… 10

An eZ-TOMAS Project contains eZ-TOMAS configuration and data files.  You should logically equate an
eZ-TOMAS Project with a specific machine that you wish to monitor.

1. On the File Menu, select New Project to open the Save As window.

New File

2. Select or create a Windows folder for the eZ-TOMAS Project.
3. Enter the name for this project.
4. Click the <Save> button to create the new project.
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Configure the Project
A default configuration is automatically loaded.  You may want to make some changes to the
configuration.  However, you can start monitoring immediately.

Configure the ZonicBook
On the Edit menu select ZonicBook to open the ZonicBook Configuration window.  Make the necessary
changes for each of the tabs and then click the <Save> button.

An in-depth explanation of eZ-TOMAS windows and menus is in the next chapter of this
manual.

�������

Clicking the Cancel button will cancel all the changes you’ve made since you
opened this window.

• Acquisition Configuration sets up parameters for the ZonicBook FFT analyzer.
• Channels Configuration sets up the parameters for the input channels.
• In the Spectral Bands Configuration panel the first four Bands are predefined.  You can modify Bands

5 through 10 for your specific application.
• Data storage configuration specifies the trigger events that will activate data storage.  If any one event

is triggered, data from all channels is stored.  Data storage events are triggered when a change occurs
within the range of your defined parameters.

Start Monitoring
After you configure your eZ-TOMAS Project, press the Acquisition Toggle Switch in the Control panel to
start data acquisition.

Control Panel

When acquisition is active, real time overall values are displayed in the instrument gauges.  The toggle
switch is green while data acquisition is active.

To stop data acquisition, click the switch toggling it down (red).

Allow eZ-TOMAS to monitor your machine for several hours, minimum.  eZ-TOMAS needs to create a
history file of the operating condition of the machine.  If the operating condition is “right”  the history file
can be used to generate limits for you.
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View Spectral Bands
You can monitor the different spectral bands by watching the gauges in the Main window.  On the View
menu select the band of interest to view gauge data.

Spectral Bands

Plot Data
Click Plots on the Main menu to open the Data Display window, or double-click on a gauge to plot that
gauge’s data.

For Real Time displays you can Halt and Resume the display of data by using the Pause/Continue toggle button,            , or
use the “P” key on the keyboard .  When viewing historical data, you can use the five playback buttons and the slider to
navigate through the data.

Multiple Plots
1. On the File menu of the Plots window, select Open Plot Window.

This opens a second display window.
2. On the Window menu of the Plots window select either Tile Vertically or Tile Horizontally.

All display windows will be displayed simultaneously, as shown below.

Plots Tiled Vertically

3. Select the Channel(s) and Display type for each window.
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A cursor is provided with each display. To move the cursor, place your mouse icon over the cursor and
drag it to the desired location on the trace. You can also use the comma (,) and period (.) keys to move the
cursor.  Cursor information is listed immediately to the left of the display.

Generate Limits
Statistical reports can and should be used to automatically generate limit values based on historical data.
After your new project has been running for several hours, there is probably enough data in the history file
to have eZ-TOMAS automatically generate limits.  However, you will want to edit these limits if the
machine is experiencing amplitude or frequency shifts.

1. On the Reports menu select Statistical; the History Data window will open

History Data Window

2. Drag the pointers across the scale to select the Start Date and Time, and the End Date and Time for
the report.  Click the OK button.  The Report will then be displayed.

Statistical Report

Limit values are not used if the HiHi  limit value minus the LoLo limit value is less than
5% of the instrument scale OR the limit value is outside the instrument range.
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3. In the Statistical Report window select Generate Limits on the File Menu;
the Limit Generation window will open.

Limit Generation

4. Select the Spectral Bands for which limits should be generated.
5. Specify the Standard Deviation to be used for Alerts and Alarms.  Two High and two Low limits will

be defined for each channel’s operating condition.
6. If you want to change the Overall % Storage Trigger (set in the ZonicBook Configuration window

under the Storage tab), click to place a checkmark in the Compute Using check box and enter the
new standard deviation to be used.

Limit Prompt

7. Click the <OK> button.  You will be asked if you want the Limits saved to disk.  Click <Yes>.
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The limits will be generated and can be reviewed/modified in the Edit Limits window, as shown below.

Edit Limits Window

You can also modify limits on the graphical gauge display in the main window by dragging the limit
arrows.

Limit Status Color Code
Red HIHI (Danger)
Light Purple LOLO (Danger)
Cyan LO (Alert)
Yellow HI (Alert)
Green OK OK

Continue Monitoring
Now that the limits are set, you will be notified of Alerts and Alarms. When the instrument status changes
(Alert or Danger), a single system beep is issued.

Are Alarms Acceptable?
You should periodically display the Alarm Log to see how many alerts and alarms you are getting in a
specific time frame.  If the machine appears to be running in a steady state, but you are getting a lot of
alarms, you may have the limits set too “tight.”  In this case you may want to modify/edit the limits.

On the other hand, if you are getting a lot of alerts and alarms, your machine may need to be adjusted or
repaired.

In either case, you are now monitoring your machine online.  From now on you will need to continue to
View and Analyze your data to help you determine if and when you should schedule a shut down for
maintenance and repairs.
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Main Menu

The main menu is laid out so that when you set up and monitor a typical project you can start with the File
menu on the left and proceed to the right.

Instrument Gauges

Instrument Gauges Panel

Each instrument gauge includes the instrument range, the current value, limit indicators,
peak hold gauge indicator, and the instrument name. The instrument gauges show one of 10 current
acquisition values. On the View menu, select the spectral band of interest.

You can specify Spectral Bands 5 through 10 in the ZonicBook Configuration window (Edit Menu) under
the Spectral Bands tab.  The default definitions are shown below.

There are shortcut (Hot) keys (1 through 0) for each display type.

No. Spectral Band
1 Overall 6 2x Amp
2 DC Gap Voltage 7 3x Amp
3 1x Amplitude 8 4x Amp
4 First Order Phase 9 5x Amp
5 1/2 x Amp 10 6x Amp

Types 1 through 4 can not be modified.  The Overall value is a time domain overall value.
Displacement probes are peak-to-peak, velocity probes are zero-to-peak, and accelerometer probes are
zero-to-rms. Types 5 through 10 are user defined and can be modified at any time.

Peak hold values for all gauges can be displayed by positioning the mouse cursor over any gauge, and
holding down the right mouse button. This will cause the peak value and the date and time that value was
reached to appear below each gauge.
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Control Panel

Control Panel

Acquisition indicates the ON/OFF status of data acquisition.  Click this toggle switch to turn data
acquisition ON (Up/Green) and OFF (Down/Red).

Limit Check indicates the ON/OFF status of the Limit Checking feature.  Click this toggle switch to turn
limit checking ON (Up/Green)  and OFF (Down/Red).

Snap Shot saves the current record and stores it in the history file.

Show Peak Hold Gauge Pointers displays the Peak Hold pointers on each gauge.

Reset Peak Hold Gauge Values resets the Peak Hold Gauges to zero.  This is momentarily
reset because the current acquisition is immediately used.

Instrument Gauge

Limit Indicators

Peak Hold Gauge Pointer
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Data Storage Panel

Data Storage/Alarms Panel

The upper bar is the data storage progress bar.  It graphically indicates how full the FIFO file is.  Below
the progress bar and to the right are two numbers.  The first is the current record number; the second is the
number of records which can be stored in the FIFO file.  The date and time range of the stored data is
displayed to the left.  Double-clicking on the bar or the text opens the plot window.

The lower bar is the Alarm Log progress bar. It graphically indicates how full the Alarm File is.
A single beep is issued when the current record number is within 5% of wrapping.  This is your indication
to backup the eZ-TOMAS Project.  Double-clicking on the bar or the text opens the Alarm Log.

Below the two bars is a “paint chip” that displays the type and color of the last alarm.  Double-clicking on
the “paint chip” opens the Alarm Log.

Relays Panel

Relays Panel

The Relay Panel contains the Relay ON/OFF toggle switch and four relay icons.  The icons indicate the
current status of the relays.  Each time you start eZ-TOMAS, the Relay switch is turned off.  You must turn
on this switch to send output to the relay channels.

If the relay toggle switch is turned on, relays will activate or deactivate depending on the configuration set
in the Relay Outputs Configuration window (accessible under the Edit menu). Each of the four relays can
also be manually activated by clicking on the relay button during an acquisition.

Tach Reference Panel

Tach Reference Panel

The Tach Reference panel displays the tach reference channels.  The tach reference associated with the
currently displayed data, when more than one tach is being used in the monitoring project.
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Security Level Panel

Security Level  Panel

The enabled radio button indicates the current security level.  Level 3 provides full screen and full access
to all menus.  Level 2 provides full screen with limited access to menus.  Level 1 provides full screen with
very limited access to additional screens and menus.

Network Panel

Network Panel

This feature requires multiple copies of eZ-TOMAS, one on each networked computer.  Each networked
computer must have eZ-TOMAS running in order to access the networking functions.  When networked, a
node as set as either a client or a server. A server must be connected to a ZonicBook, and can be monitored
and controlled by a remote client; a client does not need to have a ZonicBook connected, but can effect the
eZ-TOMAS settings on the server.

The Network Panel lists all nodes (computers) networked with this machine.  An S indicates that a
computer is acting as a Server; C indicates it is a Client to the Server; F or a blank space indicates that a
computer is free, not a server nor a client.

To add new nodes, use the Configure Network Nodes window, accessible by selecting Network... under
the Edit menu.

To the right of the list of network nodes, the current status of the network connection is displayed. The
status messages apply only to the current network connection between a client and a server. There are four
status messages which can be displayed:

• When not connected, the message “Listening to Network...” appears.
• While scanning for a ZonicBook, the message “Connecting to <computer name> on port

<number>...”. Port numbers will be searched until a ZonicBook is detected.
• If acting as a client which has connected to a server, the message will read “Received”, followed by a

series of code letters. Below this, the current time will be displayed.
• If acting as a server, and a client has connected, the message “Network Xfer. Delay: <number of

seconds>” will appear, followed by a series of code letters.
Once a network connection is established, a connection icon (two computers connected by an arrow) and a
disconnect button (a large “X”)  will be displayed below the status message. The name of the computer
connected to will also appear below the two buttons.

To connect to a network node, find the computer name you wish to connect to in the network node list,
and left-click on it. eZ-TOMAS will establish the client/server relationship.

To disconnect to a network node, click on the disconnect button, which appears at the bottom of the
network status window.
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Machine Description Panel
In the below graphic “My Machine” is set up in the ZonicBook Configuration window (Edit Menu) under
the Acquisition Tab.  The text box allows further identifying information, such as the Serial Number of the
Machine, or the Plant’s commonly used name for the machine.  If you have a digital picture of the machine
you can load that into this panel also.

Machine Description Panel
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The Menu System

File Menu

New Project
The New Project option opens the Save As window.  Select or Create a Folder where the new project’s files
should be saved.  Enter a project name, and click the <Save> button.

New Project Dialog

Open Project
The Open Project option opens an existing eZ-TOMAS project.  The Open window is displayed.
Select the project of interest, and click the <Open> button.

Open Project Dialog

Note: When eZ-TOMAS is started, it opens the last active project.

Save As
The Save As option allows you to backup history files in a binary file format, or export files in an ASCII
file format.  This command opens the Backup/Save Tomas Project window. The options in this window
change as you make selections. You can backup and export full or partial files.

Note: The disk space required to backup the selected records is displayed on the left panel.
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The Entire Project option is only available when data acquisition
is turned off.  Entire Project performs a file copy operation to the specified Windows Directory.
This backup method is the fastest.

Save As… Entire Project

The Partial Project option can be used when data acquisition is active.  This option copies data and the
configuration setup to the designated folder for the date and time range specified in the panel on the right.

Save As… Partial Project

Select the first and last record numbers you want included in the backup. Click the <Save> button.
The Save As window will open.  Select the folder where the file is to be save,
Enter a name, and click the <Save> button.

Partial Data Backup Panel

From Record #: The first record number of interest.
Start Date/Time: The first date and time of interest.
To Record #: The last record number of interest
End Date/Time: The last data and time of interest.
Destination: Where backup and exported files are stored.
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Backup Format - ASCII
This option creates an exportable ASCII file for the selected data type.  Select ASCII in the panel to the
left.  The panel on the right will activate, unless Alarm log is the pre-selected data type.  Select the type of
data you want exported in the drop down menu.  If you select Gauge or Statistics, select the first and last
records to be included in the exported file.  The entire Alarm Log file is always exported.

Save As… ASCII File

Gauge: exports the 10 bin values shown on the graphic instrument panel.
Statistics: exports the statistical report data.  It opens the History Data Window.
Alarm Log: exports the Alarm Log file.

Overlap Data
Overlapped Data, also known as Consecutive Data Blocking, is used to analyze data from large machine
transients.  It creates better resolution for rapid machine acceleration rates (>100 rpm/sec).  Overlap data
uses the second part of a block of data and overlaps it with the first part of the next block of data to
create a new block of data with an increased number of data points.  When the overlapped data is displayed
in a plot, the resolution is increased for better analysis.

History Data Window

1. On the File Menu select Overlap Data to open the History Data window.
2. Select the start and ending time to be included in the overlap process.
3. Click the <Overlap> button to open the Save As window.
4. Select the destination folder, enter a name and click the <Save> button.

Display this data later by selecting Overlap as the data source in the Plots window.
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Erase History File

Erase History Prompt

Use with caution.  This menu item will erase the History File for
 this project. All data will be permanently removed.  It is not recoverable.

Print
Prints the current screen.

Exit
Closes the eZ-TOMAS application.

Edit Menu
To modify the eZ-TOMAS Project configuration, select “Edit” on the menu bar.

• To configure the Analyzer select ZonicBook.
• To set up the lower and upper alert and alarms select Limits.

ZonicBook Configuration Window
This window has individual panels for configuring the ZonicBook. Click the appropriate Tab at the top of
the window to view the “Acquisition,” “Channels,”  “Spectral Bands,” and “Storage” panels. Make the
necessary changes in each panel. Click the <Save> button to save all your changes and close the window.

Clicking the Cancel button will cancel all the changes you’ve made since you opened
the window.
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Acquisition Configuration Tab
This tab is used to configure how the ZonicBook will process acquired data.

ZonicBook Acquisition Tab

Block Size: is the number  samples per block of vibration data.  For example, a 2048
Block size contains 2048 data samples and will produce an 800 line spectrum.
A larger Block size provides greater data resolution.  However, it takes longer
to collect the data and more disk space to store it.

Analysis Frequency: is the maximum frequency of interest.  The sampling rate will be 2.56 times
the analysis frequency.  Verify the maximum frequency response of your
probes.  For a Tach signal, your Analysis Frequency should be a higher
multiple of the maximum rotating speed.  Typically, this multiple is at least
10 times the rotating frequency.

Low Frequency Cutoff: Allows you to eliminate the lower frequencies from the full frequency range.
Number of Averages: The number of data blocks averaged before a block of data is accepted and

displayed.
FFT Window
(Weighting window):

is typically either Hanning or Flat Top. Hanning provides better frequency
resolution. Flat Top provides better amplitude resolution.

RT Display Buffer: This option is primarily for Strip Chart Displays.  It controls the amount of
time that is displayed across the x-axis.  Your choices are up to 480 minutes.
The longer times are especially useful when you are trying to see trending for
a slow process.

No. of Waterfall
Traces:

This selection allows control over the number of traces that appear on a
waterfall chart display, selectable in the Plots window. A high number of
traces will increase the resolution of the chart, but a low number of traces
may be preferable for plots which do not have clearly defined peaks.

Machine Name: Type a machine name in the data entry box.  This name will appear in the
lower right corner of the Main Window.

You must turn acquisition off and then on again for Acquisition Configuration changes
to take effect.
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Channels Configuration Tab
This tab is used to configure each channel for your project.  The available setup options in this window are
dependent on the instrument type selected.

Select a channel; then set the instrument type and set the value for each attribute.  Repeat for each channel.

The parameters of one channel can be copied to another channel by using options on the
Edit menu.

ZonicBook Channels Tab

Configure the DipSwitches for each probe based on probe type.
Refer to the ZonicBook Getting Started Manual for more information.

No.: is the channel.  Selecting the channel number highlights all attributes for that
channel.

Type: is the type of instrument attached to the channel.  Your options are
Accelerometer, Velocity, X Probe, Y Probe, Z Probe, Static and Tach.  If the
channel does not have an instrument attached, select Unused.

Name: is a Label you will use to identify the channel.
Min, and Max: represent the instrument range.
Units: is the Engineering Units you want to use.  Your options are mils or microns.
FSV
(Full Scale Voltage):

is the maximum input voltage for the instrument.  If you are unsure of the
instrument’s maximum voltage value, select a high voltage value.

mVolt / EU: is the instrument sensitivity.  (Typical displacement probes: 200 milli-Volts per
mil.  Typical accelerometer probes: 100 milliVolts per G.  For Tach probes
enter 1000.) For static channels, this property represents the slope variable of a
linear equation (the “m” of “y=mx+b”).

Integration: Accelerometer and Velocity signals can be integrated.  Select the desired
integration value.  If the signal is acceleration, then single integration results in
velocity, and double integration results in displacement. If the signal is velocity,
then single integration results in displacement.
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Integration Units: are g’s/ips/mils, g’s/ips/mils, g’s/ips/in, and g’s/mmps/mm.
Angle: is the physical angular location of a probe.  Zero degrees is defined to be the

top dead center.  The angle value is measured in the counterclockwise (CCW)
direction as viewed from the driver end.  For example, if your proximity probe
is located in the top dead center of the bearing housing,
the Instrument Angle is 0 degrees.  Orbit and Polar displays utilize Instrument
Angle for data correction.

Gap Volt: is the DC voltage value when the shaft is at rest.  This value is used for Shaft
Center Line displays.

1xAmpRef and
1xPhsRef:

are the slow roll values used for Runout Compensation on Bode or Polar
displays.

Rotation: is the shaft’s rotation direction, either clockwise (CW) or counter-clockwise
(CCW), as viewed from the driver end of the machine train.

Trig/Rev: is the number of pulses per 360 degree revolution. (Default: 1)
Trig Dir: is the “negative’ or “positive” direction of the moving shaft.
Trig Volt: define the Tach pulse for tach signals.  A keyway will generate a Negative

Tach pulse.  Typical Tach signals will generate at least a 1 V pulse.  You can
check the voltage value using a TIME display.  For Static channels, this
column represents the offset variable of a linear equation
(the “b” of “y=mx+b”)

Paired To: associates 2 probes on a bearing.  Typically, probe pairs are located 90 degrees
apart.  Orbit displays require a Channel Pair.  If you have a Tach signal or
displacement probe, you also need to configure the Channel Pairs.  [Default:
No channels are paired.]

Bearing Clearance: is measured in the instrument’s engineering units.  You can optionally overlay
the bearing clearance circle onto an orbit display.
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Spectral Bands Tab
Up to 10 Spectral Bands of interest can be defined for each dynamic channel.  The first four Bands are
predefined.  You can modify Bands 5 through 10 for your specific application.  Spectral Band values are
displayed on the dynamic instrument gauges.

ZonicBook Spectral Bands Tab

Tach Reference: is (are) the tach channels being used in the project.  You must select the
tach of interest.

Channel Name: is the name you assigned to the input channel in the Channels Panel.
Band: is the Spectral Band Number  (5 through 10) of interest.
Spectral Band Name: is the name you assign to this Band.  It is displayed on the dynamic

instrument gauge in the main window.
Range Low and Range High: is the frequency or order range.  Suggestion:  Make sure the range is

2 to 4 spectral lines wider than the frequency of interest.  This is due to
the FFT window.  For example, if your frequency of interest is the 3rd

order.  You should specify a range of 2.9 to 3.1 orders
Units: can be either Frequency or Orders.  If you do not have a tach defined, the

Orders option is not available.
Find: specifies Peak or Overall.  Peak is the highest spectral amplitude within

the specified range.  Overall is the vibrational sum of each spectral
amplitude within the specified range.
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Storage Tab

ZonicBook Storage Tab

Data storage is activated by trigger events.  If any one event is triggered, data from all channels is stored.
Data storage events are triggered when a change occurs within the range of your defined parameters.  You
can configure the system to store data every:

“N” seconds (Time Change), and/or every

“N” RPM (Speed Change), and/or

“N” % change in Full Scale Voltage (Overall Change).

For example, if your Overall Change trigger is set to 5% and the instrument scale is 0 to 5 mils,
eZ-TOMAS will store time and spectral data for all channels when the overall value changes by 0.25 mils
since the last trigger event.  All event triggers are reset whenever any event trigger occurs.

Time Change: is a time-based storage trigger.  Enter the number of seconds, minutes, hours, or days
between desired storage events.

Speed Change: is an RPM based storage trigger.  Data will be stored when the machine speed
changes by the defined value in rpm, Kcpm, or Hz.

Overall Change: is an amplitude-based storage trigger that can be defined for each channel.  Data is
stored when the overall amplitude changes by the percentage of Full Scale specified.
[Default: 5% of full scale]
This can be controlled on a channel-by-channel bases by selecting “True” or “False”
in the Enabled column.

RPM Range: The range in which a one of the above changes must occur to trigger data storage.
Storage options can be Data Only, Alarms Only, Data and Alarms, or Not Enabled.
When Not Enabled is selected, any of the above changes can cause data to be stored
regardless of the frequency range in which it occurs.

Data File Size: is the number of storage records and the number of Alarm Records in the History
FIFO (First-In-First-Out)  file.  The amount of disk space needed, based on your
configuration, is shown to the right

eZ-TOMAS maintains several data files, including Time and Gauge data.  Gauge data can be displayed in
the gauge display window.  The history file is a FIFO file.  You can define the depth of the history file;
however, the amount of time needed to fill the file depends on the trigger event values.  The smaller the
trigger values, the faster the history file fills.  The current data storage status is shown in the Main Window.
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Limits
There are two ways to generate and modify limits. The global way is to use the statistical report.  Statistical
reports can and should be used to automatically generate limit values based on historical data. The Limits
window is used when you want to modify specific limits. It is not an efficient  way to generate limits.

For more details on setting limits refer to the section Statistical Report

Edit Limits

Up to two High and two Low limits can be defined for each channel’s operating condition.

When the instrument status changes (Alert or Danger), a single system beep is issued.

Limit values are not used if the HiHi minus the LoLo limit value is less than 5% of
instrument scale OR the limit value is outside the instrument range.

The limits from one channel can be copied to another channel using options on the Edit
menu..

Limit Status Color Code

Red HIHI (Danger)
Light Purple LOLO (Danger)
Cyan LO (Alert)
Yellow HI (Alert)
Green OK (Within Limits)
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Tach you may have up to three tachs per project.
Channel Number of interest.  The Instrument Name you assigned to the channel is

automatically displayed.
Spectral Band to which the limits should be applied. ( i.e. Overall, DC Gap, 1xAmplitude,

1xPhase)
HIHI, HI, LO, LOLO are Limits.  Type limit values in the table.

You can modify limits on the graphical gauge display in the main window by dragging the
limit arrows and then opening this window to save your changes.

Files is the number of Alarm event files.  When a Red Alarm occurs, eZ-TOMAS
automatically saves data surrounding the event to an Alarm Event file.

Pre Recs is the number of records prior to the alarm.
Post Recs is the number of records after the alarm.
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Relay Outputs

Output Relay Configuration

Use this panel to configure the responses of your output relays Automation Module.  This device allows
you to have relay switches open and closed based on limit/alarm status.  You can use up to four relays.

The color of the response channel in the Relay Output panel indicates the limit/alarm status that will cause
the relay to change status (open/close).  Click on a channel number until the desired limit color  is
displayed.  If the relay is normally open  when monitored data causes the specified limit/alarm, the relay
will change to close for the duration specified by the timer; and then it will reopen.

Additionally, you can have the system count the number of consecutive alarms and change the relay status
when that number of alarms is reached.

Communication Panel
The following conditions must be met for proper output of each device.

Device:  The Output Relay module (currently 1).

COM Port:  Select the COM Port to which the output Relay module is connected.

Relay Output Panel
Relay button:  The number of the relay.  Up to 4 can be used. Click on this button to activate or deactivate
the relay.  Green = ON/activated, Red = OFF/deactivated.

buttons:  Sets the default state (normal operating state) of the relay.

         = Normally Open and               =  Normally Closed.

Timer:  The amount of time required for a part to pass through the open gate.

When you click the Save button, any of the unchecked check boxes for relay channels
will close and stay closed until the condition is met for that relay channel.  If you have
something that will actuate when the channel closes, it will do so as soon as you click the
Save button.
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Network
Networking requires your eZ-TOMAS monitoring system to be connected to a network with at least one
other PC running an additional copy of the eZ-TOMAS.

Configure Network Nodes

This feature requires multiple copies of eZ-TOMAS. Each networked computer must have eZ-TOMAS
running in order to access the networking functions. When networked, a node as set as either a client or a
server. A server must be connected to a ZonicBook, and can be monitored and controlled by a remote
client; a client does not need to have a ZonicBook connected, but can affect the eZ-TOMAS settings on the
server.

The Configure Network Nodes window (accessible from the Edit...Network menu) allows you to add
remote computers to the list of available network nodes. Computers which have been added are displayed
in the network panel of the main eZ-TOMAS screen. To add a computer, complete the following fields in
the Configure Network Nodes window:

Name / I.P. Address should be filled with either the computer’s network name, or its IP address. Your
network administrator should know both of these values.

The Project password is your security level password.

Delay is the rate in seconds that the client computer will be updated by the server computer.

Port Timout Delay is the amount of time that eZ-TOMAS will scan a computer’s port for a ZonicBook. If
the timeout is reached, eZ-TOMAS will search the next port, until all ports have been scanned.

Networking eZ-TOMAS allows you to monitor and control acquisitions from a distance. For instance, if
you are monitoring a fan with eZ-TOMAS somewhere in the plant and you also have a PC in your office
with a second copy of eZ-TOMAS running, you can monitor the fan from your office. Add the node at the
fan location to eZ-TOMAS, enter the desired delay time, and then left-click on the computer name in the
Network panel of the eZ-TOMAS main screen.  After  connecting, you can see the Fan data at your desk by
selecting the Fan’s Node in the Main window.  You can even reconfigure some aspects of eZ-TOMAS
program at the remote site, such as the acquisition and channel configuration.
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Copy Window
This command allows you to copy the currently selected window to the clipboard.  You can then paste the
copied window into another application, such as Microsoft Word or Excel.

Load Graphic Picture
This command places the selected graphic ( .bmp or .jpg format) into the lower right corner of the
Main Window.

Remove Graphic Picture
Removes the graphic from the Main window.

View Menu
The gauges in the Main Window display the real time data for the selected spectral band.

Plots Menu
Click Plots... on the Main menu to open the Data Display window, or double-click on a gauge to plot that
gauge’s data.

For real-time displays, you can halt and resume the display of data by using the Pause/Continue toggle
button, or use the “P” key on the keyboard. When viewing historical data, you can use the five playback
buttons and the slider to navigate through the data.

You can view either real-time data or historical data via this menu option.

Select the channels to be displayed, the data display format, and the data source.

Data Display Window

Display Window
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Channels, , are inputs channels.  The number of channels that can be displayed is
dependent on the plot display format.  Multiple channels can be displayed on Time, Spectrum, and Strip
Chart displays.

A single channel is shown on Waterfall, Polar and Bode displays.  For Orbit displays, a channel pair
(plotted coordinates) and tach channel (red arrow) are displayed.

A green channel box is a channel that is currently displayed.
A white channel is an active channel not being displayed.
A dimmed channel number is not active, thus there is no data to display.

Tach channel(s) are displayed separately to the right of input channels.

Display formats

Time Spectral   Orbit Waterfall Bode Polar Strip Chart

Recall Preferred Plot Setup

 The Recall Preferred Plot Setup buttons recalls your preferred plot setups.  A limit of four setups can be
defined.

While viewing historical data, the Save Baseline Data button,         , appears to the right of the Preferred
Plot Setup buttons. The Save Baseline Data button can be used to record a snapshot of the data displayed
on the screen. Then, while in Time or Spectrum modes, the recorded baseline can be superimposed on other
displayed data. (While in Time mode, the baseline can also be summed with the currently displayed data,
and the result is displayed.)

In the below example, a Time Display, a Strip Chart, and a Spectrum of Channels 1 and 2 are displayed
with a fourth display showing the tach signal. This setup was saved via the File -- Save Plot Setup -- Plot 1
menu selects.  It was then recalled by clicking on the 1st (left-most) icon above.

Plots Display Showing A Time Display, Strip Chart, Spectrum Display, and Tach Signal Display
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Data Source:

 

Data Source Panel Real Time (Left) and Historical (Right

The default data source is Real Time .  To pause realtime data display, click on the pause icon. 

Historical Data files include History , Overlap , and Alarm Event  files.

History Data is accumulated according to the parameters setup in the ZonicBook Storage Configuration
(Edit Menu).  Click on the History Icon to open the History Data window.

History Data Window

Enter the desired start and end dates.  The default is the entire history file.  Drag the Starting and Ending
Sliders to change the dates in the data entry areas. Click OK.  Then play back the file.

Historical Data is not available via Networking remote access.

Overlap, , processed data is only available if you have used the Overlap Data feature on
the File menu to create an Overlapped file. Overlapped data is double sampled data that is used for better
resolution.

Alarm Event, , opens a table of alarm events.  Select an alarm event in the table to display the
data surrounding the event.

Play Back History, Overlap, and Alarm Event files with the following icon set that is similar to a VCR.

In order, the controls are Rewind, Step backward one record, Step, Play, and Step forward one record.
You can also drag the pointer to a specific area of the file before you start playing back the data.
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Formatting Options
Each plot has its own set of additional formatting options.

The display formatting buttons are located below the display type buttons. Each plot has its own set of
additional formatting options. Not all of the following buttons are available for each plot.

Available buttons are as follows:

The Lin/Log button allows you to switch between Linear and Log Y-axis scaling.  If you
expand the data plot this feature is disabled until the plot is returned to its
original scale with the Autoscale scale button.

The Instrument Scale/Autoscale/User Scale button toggles between the three modes as follows:

The Instrument
Scale button

displays the data based on the instrument’s Engineering Units range. This
is the default display format.

The Autoscale icon toggles between original scale and autoscale.  Autoscale will scale the axes
based on the data being displayed. Autoscale uses the standard 1, 2, 5 type
scaling.

The User Scale
button

displays the data based on your selections.

The Display Gauge
Values button

opens a floating table of gauge values.

Gauge Information Table

The Display Cursor
button

opens a floating table of cursor values.

Cursor Value Table

The Show Limits
button

superimposes limits onto the displayed data.

The Show List
Table button

opens a table of gauge information. The “L” key on the keyboard can be
used to open the list.
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Peak Cursor button,  / 
Peak Cursor  is the default for this toggle button.  During data display the cursor always

finds the peak amplitude in a record.
No Peak Cursor ignores the peak and remains at the same frequency during data display. In

this case you must first drag the cursor to the desired frequency.

The Display Limits
button

superimposes limits onto the displayed data.

The Show Baseline
button

superimposes a pre-recorded baseline on top of display data. This option is
only available in the Time or Spectrum plots.

The Apply Baseline
button

sums the pre-recorded baseline and the currently displayed data. This
option is only available in the Time plot.

The Frequency Axis Mode button cycles through three different x-axis scales:

This option is only available in the Spectrum and Waterfall plots.

Freq. Axis Hz
(measured in Hz)
Freq. Axis kCPM
(measured in kCPM)
Freq Axis Orders
(measured in orders)

The Cursor Mode button cycles through four different cursor modes:

This option is only available in the Spectrum and Waterfall plots.

Normal Cursors

Harmonic Cursors

Sideband Cursors

Peak List Cursors

.

The Orbit Plot Mode button cycles through the type of orbit plot formats:

This option is only available for Orbit plots.

Orbit with SCL format

 Orbit without SCL
format
Orbit with Brg Circle
(an orbit plot including
the bearing circle).

The Overall Trace
button

displays the overall trace. This option is only available for Bode plots.

The RunOut
Compensation
button

displays a graph of the RunOut compensated values. RunOut
compensation is a vector math operation in which the referenced first-
order amplitude and phase vector is subtracted from the displayed first
order vector. This option is only available for Bode and Polar plots.
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Filtering Data

In the example below, the plot on the left is 1 rev of unfiltered data; the plot on the right is using a 1x filter
on 1 rev of data.

Plots Showing Unfiltered (left) and Filtered Data (right)

The below example is showing 1 rev of 1x filtered data on the left and 2 rev of 1x filter on the right.

Plots Showing 1 Rev Filtered (left) and 2 Rev Filtered (right)

Expand Areas on the Graph

X-axis:  Hold down the Ctrl key while you click and drag the mouse across the area of interest.

Y-axis:  Hold down the Alt key while you click and drag the mouse across the area of interest.

Both axes:  Hold down the Ctrl and Alt keys while you click and drag the mouse around the area of
interest.
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Examples of Displays

Time Display, , shows vibration amplitude as a function of either time or rotation for a block
of time data.  The default X axis is time “Full Block.”  If the rotating speed is greater than 0 RPM, the X
axis can be specified as “N” Shaft Revolutions.  Where “N”  is 1, 2, 5, or 10.  One shaft revolution equals
360 degrees of rotation.

Multiple channels can be shown on the Time Display.

Time Display Plot

Spectrum Displays, , show vibration amplitude as a function of frequency.  The frequency
units can be either Hertz (Hz), cycles per minute (kCPM) or orders.

Spectrum Display

Multiple channels can be shown on the Spectrum Display.
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Bode Displays, , show vibration amplitude and phase as a function of rotating speed. The

blue trace is the first order amplitude values. The black trace displays  the overall values .

You can optionally display the Run Out compensation values  on the same plot as a red trace.

Compensation values are specified for each channel in the Configuration.

Run Out Compensation is a vector math operation. The referenced first order amplitude and phase vector is
subtracted from the displayed first order vector.

Bode displays only one channel.

Bode Display

Bode Plot with Overall Trace
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Bode Display with Runout Compensation

Orbit Displays, , show simultaneous time  domain vibration amplitude for a X-Y probe pair.

The red arrow displays the tach reference marker and indicates  the direction of the time signal.  The
default display is “Full Block” of time data.  A limited number of Shaft Revolutions can be displayed
(1, 2, 5, or 10).  The orbit display is corrected for probe location.

You can optionally overlay the orbit onto a shaft center line display by clicking the Orbit w/ SCL button.
The center of the orbit trace in SCL computes the difference between the current gap voltage and the
reference gap voltage. Click the button again to display Orbit w/o SCL. Click once more to display the
Orbit w/ Brg Circle.--the bearing circle clearance is then also shown.

Only one probe pair can be shown on the Orbit Display.

Orbit Display
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Orbit Display with Shaft Center Line (SCL)

Polar Displays, , show vibration amplitude and phase lag on a polar plot format. The
data is corrected for probe location.  Phase lag is opposite the direction of rotation.  You can optionally
display the “Run Out” compensated values (shown as a black trace) by selecting the “Show Compensated”
check box. The compensation values are specified for each channel in the ZonicBook configuration. Run
Out Compensation is a vector math operation.  The referenced first order amplitude and phase vector is
subtracted from the displayed first order vector.

Only one channel can be shown on a Polar Display.

Polar Display
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Strip Chart Displays, , show selected instrument gauge values as a function of date and time.

Strip Chart Display

Waterfall Displays, , show rpm data in 3D.

Waterfall Display



ZonicBook 10-30-01 eZ-TOMAS, pg.  41

Reports Menu
eZ-TOMAS has two types of reports – Statistical and Alarm Log.

Statistical Report
The Statistical Report lists the historical spectral band data.  It includes the instrument, the engineering
units, the minimum value, the mean average value, the maximum value, and the standard deviation by
channel.

Statistical Report

The report can be saved as an ASCII text file for further use.

This data can be used to generate or fine tune limits.  You can have eZ-TOMAS automatically compute
limit values by selecting Generate Limits on the File menu.  You can view and modify the limit by
selecting Limits on the Configuration menu.

1. On the Reports menu select Statistical, the History Data window will open.

History Data Window

2. Drag the pointers across the scale to select the Start Date and Time, and the End Date and Time for
the report.  Click the OK button.  The Report will then be displayed.

3. Save the Statistical Report as an ASCII text file by selecting Save the Report on the File menu in this
window.
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Generate Limits
Statistical reports can and should be used to automatically generate limit values based on historical data.
After your project has been running for several hours, there is probably enough data in the history file to
have eZ-TOMAS automatically generate limits.  However, you probably will want to edit these limits if the
machine is experiencing amplitude or frequency shifts.

This feature can be used at any time during the life of a project.

1. On the Reports menu select Statistical; the History Data window will open

History Data Window

2. Drag the pointers across the scale to select the Start Date and Time, and the End Date and Time for
the report.  Click the OK button.  The Report will then be displayed.

Statistical Report Window

Limit values are not used if the HiHi  limit value minus the LoLo limit value is less than
5% of the instrument scale OR the limit value is outside the instrument range.
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3. In the Statistical Report window select Generate Limits on the File Menu; the Limit Generation
window will open.

Limit Generation Window

4. Select the Spectral Bands for which limits should be generated.
5. Specify the Standard Deviation to be used for Alerts and Alarms.  Two High and two Low limits will

be defined for each channel’s operating condition.
6. If you want to change the Overall % Storage Trigger (set in the ZonicBook Configuration window

under the Storage tab), click to place a checkmark in the Compute Using check box and enter the
new standard deviation to be used.

7. Click the OK button.  You will be asked if you want the Limits saved to disk.  Click Yes.

The limits will be generated and can be reviewed/modified in the Edit Limits window, as shown below.

Alarm Log Report
The Alarm Log contains the last “N” number of alarms.  The number of alarms was specified in the
ZonicBook Configuration window under the Storage Tab.  The Alarm Log displays, in a grid format, the
Channel, its name, the date and time of the alarm, the type of alarm, and the value of the signal at that time.

Alarm Log Report

HiHi / LoLo (Danger) limit values = average +/- (4 * standard deviation), unless you changed the standard
deviation in the Limits Configuration window.

Hi / Lo (Alert) limit values = average +/- (2 * standard deviation), unless you changed the standard
deviation in the Limits Configuration window.   To save this report, select Save the Report on the File
Menu at the top of this window.

To export this data to an ASCII file, select Backup/Export on the File menu in the Main window.
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ZonicBook Configuration
The option creates a text file that contains the details of the current projects configuration.

ZonicBook Configuration Report
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Security Menu
eZ-TOMAS has 3 Security Levels.

Level 1 has very limited privileges – Exit, Print, Generate Alarm Log Report, and View Gauge data in the
Main menu.

Level 2 has only a few limitations.  The Level 2 operator cannot start a new project, Erase the History file,
or change the security password.

Level 3 has full privileges.  Level 3 is password protected.

No password is required to go from Level 3 down to Level 2 or Level 1.  However, the project password is
required to move from Level 1 or Level 2 to a higher level.

Change Password
This command opens the Project Password window.

Edit Password Window

Type a password that you can remember and press the <Save> button.  The window will then clear your
typing.  Retype your password and press the <Confirm> button.
The new password is immediately accepted.
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Glossary
Several terms and acronyms are used throughout the following discussion, including:

Blocksize: The number of data samples used in the FFT process.

Data Block (Block of Data): An array of data samples used in the FFT process. The Data Block array size
is the “Blocksize” value.

Spectral Resolution: The Analysis Frequency divided by (the Blocksize divided by 2.56).

The Sampling Rate is 2.56 times the Analysis Frequency.

For example,

Given an analysis frequency of 1000 Hz and a blocksize of 2048,

The sampling rate would be 2560 samples per second for each channel, or 2.56 times the Analysis
Frequency

The Time Data Block consists of 2048 values.

The Spectral Data Block consists of 800 values.

The Spectral Resolution would be 1.25 Hz per spectral line.

Additional Notes
Here is a list of common suggestions for you to use eZ-TOMAS more effectively.

1. Make sure your ZonicBook Dip Switches are configured correctly.  (Typically:  Single Ended, AC
coupled, and ICP ON.)

2. Use a standard channel location convention.  (Typically:  A single Tach is channel 8.)
3. If for some reason, you have an error where eZ-TOMAS does not boot up, you can work around

the problem by deleting the file, “tomas.ini,” located in the executable’s directory.  This file
identifies the last Project opened.  You can delete this file without affecting your data.  Try reopening
the last project.

4.  If you still experience an error.  Please send an email to productsupport@iotech.com

mailto:productSupport@iotech.com
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Program Function Keys 4
Function Keys can be programmed to perform a series of key strokes.  These are kept in a separate file
“tomasfkeys.ini.”  Below is the sample file included with the software distribution.  Please note that the
first 4 characters must be Fnn=, where nn is the two digits of the Function Key of interest.

F01=HELP
F02=ACQ Turn acquisition On/Off
F03=LC Turns Limit Check On/Off
F04=SAVE Saves Snap Shot file
F05=pathfilename.tom1(all lowercase) Opens the user defined project
F06=c:\program files\data\motor.tom1 Opens the “motor” project
F09=PRINT Opens the Print window

Customize tomasfkeys.ini file
Open the file in notepad or a similar text editor.

Type the definitions for the function keys you want to use. The key words must be as listed above.

Acceptable Acceptable Not Acceptable
F01=HELP F02=ACQ F10=HELP
F02=ACQ F03=LC F02=ACQ
F03=LC F10=HELP F03=LC
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Introduction 1
What is eZ-NDT/RI …… 1
System Requirements …… 2
Order of Operation …… 3

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

What is eZ-NDT/RI?
eZ-NDT/RI is a non-destructive QA / QC inspection system based on the ZonicBook FFT.  High frequency
vibration data is collected and compared against user-defined amplitude and frequency limits.
A passed (good) part will have the maximum spectral peak(s) within the defined limit band(s).
A failed (bad) part will have one or more spectral peaks outside the defined limit band(s).

The minimum eZ-NDT/RI system includes a computer running a Microsoft windows operating system,
a 2-channel ZonicBook FFT Analyzer, one modal hammer, and one microphone.  The hammer is attached
to Channel 1 of the ZonicBook and the Microphone is attached to Channel 2.

Preparing for QA / QC inspection requires an iterative process of testing known “good” and “bad” parts.
First at least one known “good” part (preferably 10) is tested in the investigative mode.  Then known “bad”
parts are tested (preferably at least one of each defect type).  The vibration data of the “bad” tests are then
compared to the “good” tests.  At this time limit bands are defined based on vibration peaks that occur in
the “good” test that do not appear in the “bad” tests.  After up to 10 limits are defined all the parts are tested
to insure that all the “good” parts pass and all the “bad” parts fail.  Some fine-tuning may have to be done.
Because this process detects internal, non visible, defects you may have an occasional “good” part fail.
When the results of the testing are consistent, you are ready to start testing production parts in the
QA Mode.

When an automated system is used, there are other process considerations that need
to be addressed and configured.  These are typically addressed at the factory prior to
shipment.

Multiple user levels exist for your protection.  Level 3 is for the manager and allows complete access to the
System.  Level 2 is for the technician and Level 1 is for the inspector.  Levels 1 and 2 do not permit
configuration modifications, among other limitations.

The first time eZ-NDT/RI is executed, it will automatically load the default configuration parameters into
the “Project Template”.  The Project Template is located in the Windows directory where you installed
eZ-NDT/RI.  You should consider an “eZ-NDT/RI Project” equal to a unique Part that you wish to test.

For example, if you manufacture Widgets and Gizmos, you would have 2 separate eZ-NDT/RI projects,
one for Widgets and one for Gizmos. Each eZ-NDT/RI project is saved in one project file with the
extension “.ndt”—so, the widget project in the previous example might be named “widget.ndt”, and the
gizmo project might be named “gizmo.ndt”.

Each eZ-NDT/RI project is saved in one project file with the extension “.ndt.”
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System Requirements
Minimum computer requirements include:
• Intel™ Pentium® PC 90 MHz, or equivalent
• 32 MB memory
• 50 MB free disk space
• Windows 9x/Me/NT4.0/2000/XP operating system
• ZonicBook FFT Analyzer, impact hammer, microphone, cables.
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Order of Operation
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Investigative Mode Testing 2
1. Gather known “good” and “bad” parts …… 5
2. Set up the analyzer, hammer, microphone, and computer …… 5
3. Launch eZ-NDT/RI …… 6
4. Open a New eZ-NDT/RI Project …… 6
5. Select Investigation Mode …… 7
6. Configure the ZonicBook …… 7
7. Select Plot Display Type …… 8
8. Turn on Data Acquisition …… 8
9. Test All Good Parts …… 8
10. Test All Bad Parts …… 10
11. Compare the Results of Good and Bad Tests …… 10
12. Configure the Limits …… 10
13. Verifying the Limits and Ranges …… 12

The following process can be used to determine whether eZ-NDT/RI testing is feasible for the part that is
being tested.  Typically this is an iterative process, where you establish the resonant signature of the part
and determine the distinct peaks of the signature.  These peaks are then used to set up the test criteria that
eZ-NDT/RI will use.  During this process, as well as during production, it is very important that you strike
each part at a consistent location and with a consistent amount of force.

1. Gather known “good” and “bad” parts.
Locate both good and bad parts.  Typically 10 of each are sufficient.  Make sure the Bad parts include all
possible reject (failure) modes.  The good parts will be used to test for NDT/RI testing feasibility.

Block Diagram of Typical NDT/RI Setup
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2. Set up the analyzer, hammer, microphone, and computer.
Connect your analog input signals to the ZonicBook’s BNC inputs. Configure the ZonicBook as needed.

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

a. Connect the Impact Hammer to Channel 1.

b. Connect the Microphone to Channel 2.

c. Place the microphone within range of the output.

3. Launch eZ-NDT/RI.
To run eZ-NDT/RI, double-click the eZ-NDT/RI icon or use your Windows desktop Start button to
navigate to the program file.

First Time Running eZ-NDT/RI

Registration Form

Note:  After you have completed the following steps, each succeeding time that you start eZ-NDT/RI you
will be taken immediately to the main screen.

A registration form will open the first time you run eZ-NDT/RI.  You must complete the information in this
form to enable the eZ-NDT/RI application.

The password accompanies your CD-ROM.  You will not have to re-enter this information again, unless
you upgrade to a newer version, or have to re-install eZ-NDT/RI.

eZ-NDT/RI will open to its main screen, as shown below.

eZ-NDT/RI Main Window



ZonicBook 10-30-01 eZ-NDT/RI, pg.  7

4. Open a New eZ-NDT/RI Project.
Each eZ-NDT/RI Project contains configuration and data files.  You should logically equate an eZ-NDT/RI
project with a specific part that you wish to inspect.

Because multiple eZ-NDT/RI Projects will exist on your computer we suggest you create project
folders to organize and save your files.  These folders can be located anywhere on your system.

a. On the File menu select New Project to open the “Save As” window.

b. Select a folder for your eZ-NDT/RI Project or create a new folder.

Save As Dialog

If you created a new folder...

With “New Folder” highlighted, type a name for the Project Folder. Then, double-click on the folder to
open it.  This is where you will save your new project files.

c. Type a filename for the project, including the file extension, in the File name data entry box.
 i.e.  part234.ndt

NDT.ndt is the default template.  DO NOT use that filename.

d. Click the Save button to create the new project.  Now all the files for this project will be saved in the
folder you just used.

5. Select Investigation Mode.
On the main screen select Investigation Mode.

6. Configure the ZonicBook.
To start use the default values.

If you have tested both good and bad parts, and you do not see a difference between them,
you may need to modify one or more of the configuration values.
Increasing the Trigger Delay is the most common solution.
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7. Select Plot Display Type.

The plot display types are selected by clicking on one of the above two icons.  The one on the left is a time
wave display and the one on the right is a spectrum display.  Click on the Spectrum icon.

8. Turn on Data Acquisition.
Click the Red toggle switch in the Acquisition panel of the Main window.  This will initialize the
ZonicBook.  Wait for the Ready status.

9. Test All Good Parts.

Parts Panel

Select the Good Part radio button.

Strike the parts several times at a consistent location with a consistent amount of force.  It is likely that the
part will indicate “FAIL”  because limit bands have not been set.
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If you do not see anything on your plot,  click on the <Autoscale> button,  ,

or the <lin/log> button,  to expand the y-axis.

Using the logarithmic scale tends to enhance the peaks making it easier determine relevant
and significant peaks.

Linear Scale of Initial Strike

b. Click the Autoscale Icon, , to have the Y axis minimum and maximum scaled to the data.

Autoscale of Initial Strike
(Logarithmic Scale)
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10. Test All Bad Parts.

Parts Panel

a.  Select Bad Part.

b.  Select the number of bad parts you intend to test at this time on the Test Parts menu.

c.  Test the bad parts in the same manner used in Step 8 above.

11. Compare the Results of Good and Bad Tests.
Visually locate the spectral differences between the Good Part (Blue Line) and Bad Parts (Red Lines).
You are looking for resonant peak(s) that shift in frequency (red lines to the left or right of the blue line)
and/or amplitude (red lines shorter or taller than the blue line).  If blue and red peaks are almost identical,
they are probably not good choices.  Ideally you will find significant single peaks.

Because this process detects internal, non visible defects, you may have an occasional
“good” part fail.

12. Configure the Limits.
Modify the limit bands to match the “Good” part’s spectral peaks that you want to use. As mentioned
earlier, this is an iterative process.  Quite often not all your “Good” parts will pass with these exact limits
the first time.

There are four limit bands already placed on the plot.  These limit bands are green acceptance limits—
peaks for subsequently tested parts must be within these limits to be counted as “Good” parts.  Working
from left to right, drag the first band to the first peak you want to use.  Next, drag the second band to the
second peak you want to use.

If you do not need all four of the limit bands, delete the extra bands.

To delete a Limit Band, right-click on the Limit button, select Delete Limit.

Limit
Buttons

Status Panel

If you need more limit bands you can add up to a total of 10.
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To add a Limit Band, right-click on the Channel button, select Add Limit.

Channel
Button

Status Panel

Right-click on the Channel
and select add Limits

The new Limit Band is
always added in the middle
of the plot

Adding a new Limit Band
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13. Verifying the Limits and Ranges.
a. Switch to QA Mode.

b. Test all the known “Good” and “Bad” parts.  You are looking for consistent results.
Do they pass and fail as expected?

• If yes you are ready to go to production.

Click the Save Limits Icon, .

• If no, answer the following questions.
-- Are any peaks just a little bit out of range?  Modify those limit bands a little.
-- Are there peaks that you missed the first time?  Add a limit band.
-- Are there two peaks that are fairly close, one within the band and one not?

Sometimes you will have 2 closely spaced peaks.  These peaks will “fight” for dominance.

You can either remove that entire range, widen the range to include both peaks, or split the range
with one peak in each range.

c. Re-test the “Bad” parts.

Did all the Parts FAIL?

If no, you need to go consider setting amplitude limits. Sometimes, the only difference between
a good and bad part is a difference in amplitude of a significant peak.   You can change the amplitude
of a limit band by right-clicking the top or bottom of a limit band and dragging it up or down.

Right-click and
drag the Limit
Band up or down

Changing the Limit Sizes

If you still can’t distinguish between “Good” and Bad parts, try changing the Pre/Post Trigger Delay
Percentage value of the trigger channel.  By increasing this value, you are delaying the start of the sound
measurement.  This delay can be very helpful identifying cracked parts, because a cracked part can not hold
a tone.  The resonant frequencies of a cracked part die out quickly.
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Q/A Mode Testing 3
1. Launch eZ-NDT/RI …… 13
2. Open the eZ-NDT/RI Project …… 13
3. Turn on Analyzer …… 13
4. Test Parts …… 14
Reviewing NDT/RI Inspection Results …… 14
Preparing Reports …… 15

A feasibility test and setup of the test parameters must be completed prior to starting
production testing.

1. Launch eZ-NDT/RI.
To run eZ-NDT/RI, double-click the eZ-NDT/RI icon or use your Windows desktop Start button to
navigate to the program file.

2. Open the eZ-NDT/RI Project.
Select Open Project on the File Menu.  Find the project of interest and double-click on it.  This will open
the project and set up the test parameters.

3. Turn on Analyzer.
Click the Red toggle switch in the Acquisition panel of the Main window.  This will initialize the
ZonicBook.  Wait for the Ready status.

Acquisition Panel (Off) Acquisition Panel (On)
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4. Test Parts.
If you are using an automated system, start the conveyor and start loading parts onto the conveyor.

If you are using a manual system, strike the part, at the prescribed location, with the hammer.
eZ-NDT/RI performs the inspection process when the “Force” channel’s trigger conditions are met.

After you strike the part, check the Hammer Status message in the Acquisition Panel and the Status Panel.
If your hammer strike resulted in a Trigger, you will see the NDT/RI inspection results, PASS or FAIL.

Note on Performance Speed:  Each part may take from 1-2 seconds to test under Level 3.  For quicker
results switch to Level 1 (graphics are not updated).

Troubleshooting:  If the Trigger did not occur, you need to verify one or more possible causes.

• There is a hardware problem.  Check the trigger channel’s cable connections.  If this instrument
requires ICP verify the ZonicBook Dip Switch settings.

• There is a configuration problem.  Check the trigger channel’s FSV and Trigger Percentage.  The input
trigger voltage may be lower than the configuration settings.  If you are operating at the Technician or
Operator level, you will need to change the User Level to Manager to check and make changes to the
configuration settings.  Clicking the “Reset/Set Default” button will normally correct any problems.

Reviewing NDT/RI Inspection Results
The Summary Panel contains the NDT/RI inspection results since the last time the <Reset Counts> button
was pressed.  The total number of Passed and Failed parts, as well as the consecutive count, are listed.
The Since label shows the last time the <Reset Counts> button was pressed.  The <Reset Counts> button
clears the Passed / Failed / Consecutive / Since labels.  It does not erase the data stored in the history file.
The Last label displays the date and time of the last NDT/RI inspection.

The above information can be removed from the screen by pressing the Review Summary Counts
button, .
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Preparing Reports
After each NDT/RI inspection, the test results are stored in the history file.  This is a FIFO,
“First-In, First-Out”  file.

eZ-NDT/RI is capable of generating three types of reports from this history file: Production, Plot Data,
and Configuration Settings. Select any option for that type of report to be generated. These reports are text
files—after selecting a report type, you will be prompted to enter a filename for the text file using a
standard Windows dialog box. The features of the three report types are as follows:

Production Report – After choosing Production from the Report menu, a production report dialog box
opens. It displays two radio buttons, allowing the user to choose either a Summary or Detailed production
report.

• The Summary report lists the inspection status of each part tested over the selected date and time
range. The serial number and inspector name is also listed.

• The Detailed report, in addition to the information contained in the summary report, also provides the
measured frequency and amplitude peak for each spectral band on a given response channel.

• Both the Summary and the Detailed Report provide a statistical summary at the bottom of the report.
The statistical summary lists the counts, average, and standard deviation values for both Passed and
Failed parts.

To the right of the production report dialog box is a graphic and a sliding scale, which both represent the
amount of data held in the project’s history file. The sliding scale allows the user to choose the amount of
data which will appear in the report. To use the sliding scale:

1. Click on the green start arrow and drag it to the desired starting percentage. The date and time of the
first data point will be displayed at the bottom of the scale.

2. Click on the red end arrow and drag it to the desired ending percentage. The date and time of the
final data point will be displayed at the top of the scale.

3. Click the Okay button.

For example, if you wanted to generate a report using only the last 50% of the history file, you would drag
the green arrow to between “40” and “60” on the scale, and drag the red arrow to “100”. To use the entire
history file, leave the green arrow at “0” and the red arrow at “100”.

Plot Data Report – Choosing Plot Data from the Report menu generates a list of all the data points (using
x and y coordinates) that are displayed on the graph. The units used for the x and y coordinates in the report
will depend on whether the graph was set to the Time display or Spectrum/FRF display.

eZ-NDT/RI can also generate a Configuration Settings report, which lists many of the configuration
options that are set in the ZonicBook Configuration screen (accessible by selecting the Edit menu, and the
ZonicBook...).
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Windows and Menus Section 4
Main Window …… 17

Acquisition Panel …… 18
Relay Output Panel …… 18
Display Panel …… 18
Status Panel …… 19
Summary Panel …… 20

Graphical Display …… 21
Limit Range …… 21
Modifying Limits from the Main Window. …… 22
Magnifying  Areas on Graph …… 22

File Menu …… 23
New Project …… 23
Open Project …… 23
Save Project …… 23
Save As... …… 24
Start/Stop Acquisition …… 24
Erase History File …… 24
Print …… 24
Exit …… 24

Edit Menu …… 25
ZonicBook …… 25

Acquisition Tab …… 26
Channels Tab …… 27
Channel Tabs- Edit Menu …… 29
Limits Tab …… 30
Limits Tab - Edit Menu …… 31

Automation Tab …… 32
Communication Panel …… 32
Relay Output Panel …… 32
Response Channel State Panel …… 33
Consecutive Panel …… 33
How Automation Relays work …… 33
Reset Summary Counts …… 33
Copy Window …… 33
Load Graphic Picture …… 34
Remove Graphic Picture …… 34

Report Menu …… 35
Generate a Production Report …… 35
Summary …… 36
Detailed …… 37
Plot Data …… 31
Configuration... …… 38

User Menu …… 39
Enter Password …… 39
Change Password …… 39
Change User Levels …… 39

Help Menu …… 39
What’s This Help …… 39
About …… 39

Main Window

Test specific information is located at the top of the display and includes Company Name, Part Name,
Serial Number, and Inspector Name.  This information is stored with the data after each NDT/RI
inspection.  Company Name and Part Name are set up in the Acquisition Tab of the ZonicBook
Configuration window.

The part’s Serial Number and the Inspector’s Name can be manually entered in the text fields shown.
A picture of the part being tested can be inserted in the top left corner.

Main Window
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eZ-NDT/RI can be operated in two modes.  Q/A Mode is for normal testing and Investigation Mode is for
feasibility testing and Limit Configuration.

Mode Panel

Acquisition Panel

Acquisition Panel

The Acquisition Panel contains the ON/OFF toggle for the analyzer.  It also displays the current date and
time, the Security Level at which it is currently operating, the status of the analyzer, and the number of
averages taken.

Relay Output Panel

Relay Output  Panel

The Automation Panel is used with the optional relay control package.  The toggle switch controls the
ON/OFF status of the eZ-NDT/RI Automation Module.  The Relay Icons indicate the current status of the
relays. Each time you start the NDT software, the Automation main switch is turned off.  You must turn on
this switch to send output to the relay channels.  Relay channels can be either be set to trigger according to
the state of a channel, or they can be triggered manually by clicking on the appropriate Relay Icon.

Display Panel
The Display Panel contains the following display related options.

Display Panel
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Show Cursor Values: Cursor values are only shown on request.  Click the Show Cursor Values Icon to
open a floating display of the cursor values.  Click on the upper left corner of the display to move it
anywhere on the screen.  Values are displayed in the x, y format.

Cursor exists for each defined limit range.  The cursor is automatically positioned to the highest peak in the
limit range.  You can move the cursor by dragging it across the graph with your mouse or by using the
keyboard.  The “4” and “, (comma)” keys move the cursor Left.  The “6” and “. (period)” keys move the
cursor Right

Cursor Values Table

Y-axis Format:  The default is linear, Auto Scale enabled.  To change the format, click

the <Lin / Log>  button,  and the <Auto Scale> button,  Time displays are always linear.  Auto
Scale is either enabled or disabled. When enabled, the Y axis scale is 20% greater than the data range.
When disabled, the Y axis scale is defined by the instrument range in the configuration.

Data Display Formats:  The default display is Spectrum.  To change the format, click the

<Time> button, , or the <Spectrum> button .

Status Panel

Status Panel

The Status Panel includes the overall inspection results as well as the inspection results of each spectral
band for each response channel.  Green indicates “Pass”.  Red indicates “Fail”.  The icons illustrate the
current condition of the output relays (each defined spectral band limits).

Overall Part Status:   The <PASS/FAIL> button is the large button to the left of the <channel> buttons.
On eZ-NDT/RI start-up, this button is  blank.  After each NDT/RI inspection, the button’s color and status
message reflect the inspection results.  Red indicates a failed part.  Green indicates a good part.  Click on
this button to view the entire spectral range.

Channels:  <Channel> buttons are shown vertically from 1 to 8.  Both Force and Response channels can be
displayed in either the Time or Spectrum format.  Unused channels are not enabled (dimmed).

Limit Range Buttons:  The horizontal numbered buttons show the NDT/RI inspection status for the
defined limit ranges.  Red indicates fail.  Green indicates pass.  Up to 10 ranges exist for each response
point.  To display a range of interest, click on the desired <range> button.  To view the full scale, press the
<Overall Part Status (PASS/FAIL)> button. To return to the original X-axis scale, click on the
<Overall Part Status> button again.

Clicking on a <Limit Range> Button expands the graphical display to show that particular Frequency and
Limit Range.
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Summary Panel

Summary Panel

The Summary Panel provides the summary results for the most recent NDT/RI inspections.

<View Summary Counts>:  This toggle button, , is used to  hide and show the
summary counts.

<Reset Summary Counts>:  This button, , resets the summary counts to zero.
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Graphical Display

Limit Range
The Graph displays the results of a strike.  The acceptance limit regions are shaded in green;
failure limit regions are shaded red.

Graph Displaying Three Acceptance Limit Regions

The <Limit> buttons in the Status Panel control the Limit display.  Click on a <Limit> button to show a
specific Limit Range and Limit Band.

      Click to return to full view.

      Click to see Limit Range
       for this Limit Band

       Limit Band

                     Limit Range

Manipulating the Graphical Display
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Modifying Limits from the Main Window.
Add Limit Band: Using your mouse, right click on the channel of interest and select “add a limit.”  The
new limit will be placed in the middle of the frequency range. Move it to the desired location.  See Moving
acceptance area below.

Limits added in this manner will always be green acceptance limits.
To add red failure limits, use the Limits screen of the ZonicBook Configuration Menu
(accessible under the Edit menu by clicking on ZonicBook).

Remove Limit Band: Using your mouse, right click on the spectral band icon you want to remove and
select “delete limit.”

Increase/decrease Limit Band: Using your mouse, right-click on the edge of the green acceptance
 (or red failure) area.  You’ll see a left & right pointing arrow.  While continuing to press the right mouse
button you can drag the edge of the limits across the x-axis.  A small pink box displays the current location
of the mouse.  When you move the edge of an acceptance limit, the range will move accordingly.

Moving Acceptance Area: Using your mouse, right-click anywhere within the green acceptance
(or red failure) area.  You’ll see a cross.  While continuing to press the right mouse button you can drag the
whole acceptance area across the x-axis.  A small pink box displays the current location of the mouse.
Increase/decrease Amplitude Band: Using your mouse, right-click on the top or bottom edge of the green
acceptance (or red failure) area. You’ll see an up & down pointing arrow. While continuing to press the
right mouse button, you can drag the edge of the limits across the y-axis. A small pink box displays the
current location of the mouse.

Decrease Limit Range: Using your mouse, right-click on the edge of the expanded plot.  You’ll see a left
and right pointing arrow.  While continuing to press the right mouse button drag the edge of the plot across
the x-axis.  A small pink box displays the current location of the mouse.

Magnifying  Areas on Graph
X-axis: Hold down the Ctrl key while you click and drag the mouse across the area of interest.

Y-axis:  Hold down the Alt key while you click and drag the mouse across the area of interest.

Both axes:  Hold down the Ctrl and Alt keys while you click and drag the mouse around the area of
interest.
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File Menu

New Project
When you select New Project, the “Save As” window opens.  If you already have a project defined, it will
open to the folder where that project is saved.  You can create the new project here, or you can create a new
folder in which to save your project.

Save As Dialog

1. Select New Project on the File menu.
2. Find the folder in which to save this project, or create and name a new folder.
3. Type a file name (including the extension).
4. Click the <Save> button.

Open Project
The Open Project command, opens the “Open” window.

Open Project Dialog

1. Select Open Project on the File menu.
2. Find the folder in which your project was saved.
3. Click the <Open> button.

If you have an older EZ-NDT/RI project with multiple files (i.e., files with extensions “.ndt1”,
“.ndt2”, etc.), they will be combined into one file (with a “.ndt” extension) once the latest version of
the EZ-NDT/RI.exe is used to open the old “.ndt1” file.

Save Project
This menu item save the current state of your project.
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Save As...
This menu item opens the Save As window.  Enter a new path and file name for this project.  Use this
command to save setup time on a new project if it is very similar to a current or older project.

Save As Dialog

Start/Stop Acquisition
Use this command to start or to stop data acquisition.  You can also issue this command by pressing the F5
key.

Erase History File

Erase History File Prompt

�������

This menu item will PERMANENTLY erase all data stored in the history file.
You will be asked to confirm your action.  Once you have confirmed the Warning
message, there is no way to retrieve the data.

Print
The Print command prints the Main window.

Exit
Quits the NDT/RI application.  This can be performed only when the User level is Manager.
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Edit Menu

ZonicBook

This menu option is only available at Level 3 operation AND when Data Acquisition is
OFF.

The ZonicBook Configuration window includes four Tabs.  The “Channels” Tab allows you to define the
input channels.  The “Acquisition” Tab defines the data acquisition setup.  The “Limits” Tab allows you to
specify the acceptance criteria. The Automation Tab allows for output to the eZ-NDT/RI Automation
Module.  This window always opens with the channels tab active.

After you create a new eZ-NDT/RI Project, you may need to modify the configuration, select “ZonicBook”
on the Config. Menu. The ZonicBook Configuration window will open.

Normally the configuration settings defined during the feasibility study are used.
Please do not deviate from these unless you are an advanced technician.
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Acquisition Tab
Use this panel to configure the ZonicBook’s Acquisition parameters.

ZonicBook Configuration Acquisition Tab

Company: Enter your Company Name.  This label is displayed in the upper left portion of
the main graphics window and on all data reports.

Part Number:   Enter the Part Number for this eZ-NDT/RI Project.  This label is displayed in
the upper left portion of the main graphics window and on all data reports.

History File Size: Enter the desired History File Size.  The history file is a FIFO file.  This value is
the size of this file.  The total amount of required hard disk space for the
requested file size is displayed below the History File Size data entry box.
The amount of disk space required cannot exceed 2.1 gigabytes.
Data is stored to the history file after each NDT/RI analysis.

Block Size: Select the desired Block size.  This value is the number of samples per block of
data.  For example, a 2048 Block size contains 2048 data samples and will
produce an 800 line spectrum.  A larger Block size will provide you with greater
data resolution.  However, it takes longer to collect a block of data.

Analysis Frequency: Select the desired Analysis Frequency.  This value is the maximum frequency of
interest.  The sampling rate will be 2.56 times the analysis frequency.  Verify
the maximum frequency response of your probes.  Typically, the analysis
frequency will be 20 KHz. [Default:  20 KHz.]

Number of Averages: Select the desired Number of Averages.  This value is the number of data blocks
used in the NDT/RI analysis.  Typically, the number of averages is set to one.

y-Axis Scaling: Select either EU Amplitude or dB.
Calculate: The Calculation Mode determines whether Spectrum or FRF mode will be used.

FRF mode is generally preferred for getting data from multiple parts quickly;
Spectrum mode should be used for small numbers of parts, or slower
acquisitions.

Number of Flashes: The number of times the results of each test will flash on the screen.
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Channels Tab
Use this panel to configure each input signal for your project. Set the values for each channel attribute.
Repeat for each channel.

Double click in a cell to edit its value.  Use the scroll bar to view the entire table. You can copy the
attributes of one channel to another by holding down  the Shift Key and clicking the desired channel.

ZonicBook Configuration Channels Tab

No.: Select the Channel button representing the  channel you are setting up.
Type: Select the instrument Type on the pull down menu.  Types include Force, Response, and

Unused.   You must have 1 Force Channel and 1 or more Response Channels.
[Default:  Channel 1 is the Force channel; channel 2 is the Response channel;
channels 3 through 8 are unused.]

Configure the Dip Switches located under the ZonicBook Input Module for each probe.
Typically, Hammers, Microphones, and Accelerometers are Single Ended,
AC Coupled, and ICP On.

Name: Enter a Name label for the channel.  Something as simple as Trigger or Response is
okay.

Min/Max/Units
(Range):

Enter the instrument Minimum in engineering units, the instrument Maximum in
engineering units, and the engineering Units for the channel.
[Default:  Force Units are lbf (pounds force) for modal hammers; G’s for
accelerometers; and Pa for microphones.]

Full Scale
Voltage:

Select the maximum Full Scale Voltage expected for the instrument.  Erroneous results
will occur if you select a voltage value that is less than the actual input voltage.

mV/Unit
(Sensitivity):

Enter the instrument’s input Sensitivity.  Typical accelerometers have a sensitivity of
100 mV per g; microphones have 25 mV per Pa; and hammers have 1 mV per lbf.
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Trigger Level
Percentage:

This value is the percentage of the full scale voltage at which the force (hammer)
signal must reach before it is recognized as a trigger event.  Each trigger event results
in a test inspection.  For example, if the FSV for the instrument is 1.000 V and the
Trigger Percentage is 10%, eZ-NDT/RI will trigger acquisition when the
Force Input is 0.100 V.

Pre / Post
Trigger
Percentage:

This value defines the start of the data block as a percentage of the block size from -
100% to +100 %.  A negative value will result in a Pre Trigger.  A positive value will
result in a Post Trigger.  For example, if the value entered is “-10”, a Pre Trigger of
10% of the block size is defined.  10 percent of the data block occurred prior to the
trigger event. For most applications, a Post Trigger is recommended.  (+10.)

FFT Window: All measurements using the FFT must take care to avoid potentially serious errors due
to the phenomenon known as “FFT leakage", in which a signal at one frequency
spreads out ("leaks") over a wider frequency range in the FFT spectrum. Intuitively,
leakage arises from cutting out a finite length "window" of data from a longer
continuous signal, causing an apparent discontinuity at the ends of the data block,
which has nothing to do with the actual signal. These "truncation" errors can be
effectively controlled, though not completely eliminated, by multiplying each data
frame by a suitable time-domain weighting-window that smoothly attenuates the data
near the ends of each block, prior to performing the FFT.
Select the desired FFT Window function for the input channel.  Your choices are
None, Hanning, Flat top, Exponential, and Force.

• None:  Do not apply a window function to the display.

• Hanning:  The Hanning window offers a reasonable trade-off of frequency
accuracy versus amplitude accuracy.

• Flat Top:  This window has a very low peak amplitude error, and its frequency
resolution is somewhat better.  Its side lobes are considerably higher.  Its
effective noise bandwidth is still almost twice that of the Hanning window,
therefore this window is used mainly to measure accurate peak amplitudes of
discrete spectral components that usually separated by at least several spectral
lines.

• Exponential:  An Exponential weight window is equal to 1.0 at the beginning of
the block and decays exponentially to a smaller value at the end of the block.
Exponential is used only with transient data that is captured with pre-trigger to
assure that the initial values in all data channels are very close to zero.
Exponential can be used with all transient excitation methods in order to force
the signals to decay close to zero, even if the block length is not sufficient to
capture all of the naturally occurring response.  If the data decays naturally to a
low amplitude within the block, so that leakage is not significant, exponential
windowing can improve the signal-to-noise ratio by giving reduced weight to
the very low-amplitude data at the end of the block.

• Force:  This is a rectangular function that helps to ensure a consistent force is
applied to each part.
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Channel Tabs- Edit Menu

Set Defaults: This menu item will  return the channel configuration to the values pre-set at the
factory.

Copy Channel: This menu item copies the configuration of a channel into memory.  Use the Paste
Channel the values to another channel.

Paste Channel: This menu item pastes to a select channel the configuration of a channel that was
previously copied with the Copy Channel menu item.

Fill Down: This menu item copies the highlighted cell down to all active cells below it.
Fill Up: This menu item copies the highlighted cell up to all active cells above it.

If the selected cell is a response channel and a force channel is above or below it, the
force channel configuration will be overwritten.

Zero All: This menu item clears the entire configuration grid.
Zero Row: This menu item clears the row in which a selected cell resides.  If no cell is selected,

the top row is cleared.
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Limits Tab
Use this panel to configure the limit criteria for each input signal.  You can define up to 10 limit ranges per
response channel.  Select the channel of interest; then define the range and limit values.  Repeat for each
range and response channel.  Copy attributes of one range to another using options on the Edit menu.

ZonicBook Limits Tab

No.: The Channel number.
Instrument: This is the response channel for which you will be setting limits.  Typically

there is only one Response Channel.
Bin: For each significant peak you wish to monitor there should be a bin with a

defined range and limits.
Range Low/High: Enter the upper and lower frequency range.  eZ-NDT/RI will find the

maximum peak within this frequency range.
Limit Low/High: Enter the upper and lower limits range.

For a green limit: if the frequency of the maximum spectral peak for the
frequency range is within the Limits range, the part passes.
For a red limit: if the frequency of the maximum spectral peak for the
frequency range is within the Limits range, the part fails.

Units: Select Frequency-(Hz) or Time-(sec) based limit checking.  Typically
Frequency is used.

Amplitude Low/High: Enter the upper and lower Amplitude Range.
For a green limit: if the amplitude of the maximum spectral peak for the
frequency range is within the amplitude range, the part passes.
For a red limit: if the amplitude of the maximum spectral peak for the
frequency range is within the amplitude range, the part fails.

Green/Red Defines whether the limit you are setting will be a green “pass” limit or a red
“fail” limit.
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Limits Tab - Edit Menu

Set Defaults: This command returns the channel configuration to the values pre-set at the factory.
Copy Channel: This command copies the configuration of a channel into memory.  Use the Paste

Channel command to paste the values to another channel.
Paste Channel: This command pastes to a select channel the configuration of a channel previously

copied with the Copy Channel menu item.
Fill Down: This command copies the highlighted cell to all active cell below.
Fill Up: This command copies the highlighted cell to all active cells above.

If the selected cell is a response channel and a force channel is above or below it, the
force channel configuration will be overwritten.

Zero All: This command clears the entire configuration grid.
Zero Row: This command clears the row in which a selected cell resides.  If no cell is selected, the

top row is cleared.
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Automation Tab

ZonicBook Automation Tab

Use this panel to configure the responses of your eZ-NDT/RI Automation Module.  This device will allow
you to have relay switches open and close based on the results of each test.  You can use up to four relays.

The color of the response channel indicates the pass (green)/fail (red) status of the part.  If the response
channel relay is normally open (green) when a part passes inspection the relay will remain open.  On the
other hand, if the response channel relay is normally open and a part fails, the relay will close for the
duration specified by the time; and then it will reopen.

Additionally, you can have the system count the number of consecutive fails and change the relay status
when a specified number of consecutive failures is reached.

Relays can be manually triggered in the Relay Output panel of the Main window by clicking on a
Relay Icon.

Communication Panel
The following conditions must be met for proper output of each device.

Device: The Output Relay module (currently 1).
COM Port: Select the COM Port that the output Relay module is connected to.

Relay Output Panel
Relay button: The number of the relay.  Up to 4 can be used.

Click on this button to activate or deactivate the relay.
Green = ON/activated, Red = OFF/deactivated.

  buttons: Sets the default state (normal operating state) of the relay.

 = Normally Open and  =  Normally Closed.
Timer: The amount of time required for a part to pass through the open gate.

When you click the <Save> button, any of the unchecked check boxes for relay channels
will close and stay closed until the condition is met for that relay channel.  If you have
something that will actuate when the channel closes, it will do so as soon as you click the
<Save> button.
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Response Channel State Panel
Shows the pass (green) / fail (red) status of the part when the relay switch is in its normal state.

Consecutive Panel
On/Off: Activates the “Consecutive Failures” counter.
Number: The number of consecutive failures required to change the relay status.

How Automation Relays work
When the result of the part is equal to the result indicated by the Response Channel button, the operating
state of the relay (indicated by the   buttons) changed and a signal is sent to the relay switch.

Conversely, when the result of the part does not equal the result indicated by the Response Channel button,
the state remains unchanged and no signal is sent to the relay switch.

Example of Automation Relay

Example Scenario:  You want all tested parts (good and bad) automatically sent on a conveyor to the next
process. Good parts go to finishing. Bad parts go to re-work.

In the event if there is any type of failure with the relay switch, you don’t want bad parts misdirected to
finishing.  Therefore you should set up the conveyor so that the gate for the good parts is closed and only
opens when a part passes.

This means that the relay switch is normally open (no current).  A good part activates the relay switch and
opens the gate.  A bad part does nothing to the relay and proceeds on to rework.  See the above diagram.

In the Automation Setup Panel, you would make the following choices.

Relay:  Green

  buttons:  , Normally Open

Response Channel:  2

Timer:  (Amount of time required for a part to pass through the open gate.)

Reset Summary Counts
Resets the summary count to zero.  This has no effect on the history file.

Copy Window
This option copies the current window so it can be pasted into another application such as Microsoft Word
or Excel.
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Load Graphic Picture
When documentation is required for your project a picture of the part being tested is useful.  If you have a
picture of your part, select this command to place it in the upper right corner of the main window.

Remove Graphic Picture
This command removes the graphic from the main window.  This is only active if a graphic has been
loaded.
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Report Menu
eZ-NDT/RI generates four reports.

Generate a Production Report
The Production report contains the overall NDT inspection results for the specified time period. To
generate a Production report:

eZ-NDT Production Report Dialog

1. Select Production... on the Report menu.

2. The production report dialog is displayed.

3. Select whether you would like to generate a Summary or Detailed production report by clicking on
the appropriate radio button.

4. Select the number of records to be included in your report by dragging the arrows up/down the scale.

5. Press the Okay button.

6. A save file dialog box will open.

7. Type a name your report file in the filename data entry box. Use a unique name for each report.

8. Click the Save button.

After generating the report, eZ-NDT/RI automatically opens the text file in Windows NotePad or WordPad.
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Summary...
The Summary Report contains the overall NDT/RI inspection results for the specified time period.
Statistical information is shown at the bottom of the report.  The serial number and inspector name are also
listed.

eZ-NDT/RI v.5.0.43
Project Path:     C:\PROGRAM FILES\ZONIC\EZ-NDT\ndt
Summary Report:   25-Oct-2001 08:57:03
Requested Range:  25-Oct-2001 08:50:01  -  25-Oct-2001 08:54:20

Company Name:     Your Company Name
Part No.:         Your P/N...

25-Oct-2001 08:50:01   FAILED
25-Oct-2001 08:50:05   FAILED
25-Oct-2001 08:50:10   FAILED
25-Oct-2001 08:53:10   FAILED
25-Oct-2001 08:53:11   FAILED
25-Oct-2001 08:53:13   FAILED
25-Oct-2001 08:53:14   FAILED
25-Oct-2001 08:53:15   FAILED
25-Oct-2001 08:53:18   FAILED
25-Oct-2001 08:53:35   FAILED
25-Oct-2001 08:53:36   FAILED
25-Oct-2001 08:53:39   FAILED
25-Oct-2001 08:53:44   FAILED
25-Oct-2001 08:53:48   FAILED
25-Oct-2001 08:53:52   FAILED
25-Oct-2001 08:53:54   FAILED
25-Oct-2001 08:54:04   FAILED
25-Oct-2001 08:54:06   FAILED
25-Oct-2001 08:54:18   FAILED
25-Oct-2001 08:54:20   FAILED

TOTAL PASSED:        0
AVERAGE PASSED:        0.00%
STD DEV PASSED:

TOTAL FAILED:        20
AVERAGE FAILED:      100.00%
STD DEV FAILED:

TOTAL:               20
AVERAGE TOTAL:       100%
STD DEV TOTAL:

eZ-NDT/RI Summary Report
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Detailed...
The Detailed Report, in addition to the information contained in the summary report, provides the measured
frequency and amplitude peak for each spectral band for each response channel.

eZ-NDT/RI v.5.0.43
Project Path:     C:\PROGRAM FILES\ZONIC\EZ-NDT\ndt
Detailed Report:  25-Oct-2001 08:56:43
Requested Range:  25-Oct-2001 08:50:01  -  25-Oct-2001 08:54:20

Company Name:     Your Company Name
Part No.:         Your P/N...

25-Oct-2001 08:50:01   FAILED  Ch 02   F  1031.3  .00018   F  4056.3  .00006   F  7818.8  .00005   F
10044.  .00003
25-Oct-2001 08:50:05   FAILED  Ch 02   F  1231.3  .00019   F  4481.3  .00005   F  8131.3  .00004   F
12181.  .00003
25-Oct-2001 08:50:10   FAILED  Ch 02   F  1231.3  .00018   F  4556.3  .00006   F  8975.0  .00004   F
10806.  .00004
25-Oct-2001 08:53:10   FAILED  Ch 02   F  1625.0  .00017   F  4700.0  .00006   F  7443.8  .00004   F
10688.  .00003
25-Oct-2001 08:53:11   FAILED  Ch 02   F  1131.3  .00018   F  5018.8  .00005   F  7450.0  .00004   F
12125.  .00003
25-Oct-2001 08:53:13   FAILED  Ch 02   F  1231.3  .00020   F  4381.3  .00006  P   8243.8  .00005   F
10531.  .00004
25-Oct-2001 08:53:14   FAILED  Ch 02   F  1231.3  .00015   F  4037.5  .00006   F  9268.8  .00004  P
11375.  .00004
25-Oct-2001 08:53:15   FAILED  Ch 02   F  1231.3  .00015   F  4318.8  .00005   F  8025.0  .00004   F
10463.  .00004
25-Oct-2001 08:53:18   FAILED  Ch 02   F  1131.3  .00018  P   5250.0  .00005   F  9256.3  .00004   F
10769.  .00004
25-Oct-2001 08:53:35   FAILED  Ch 02   F  1231.3  .00016   F  4481.3  .00006   F  8056.3  .00005   F
10119.  .00004
25-Oct-2001 08:53:36   FAILED  Ch 02   F  1231.3  .00018   F  4006.3  .00006   F  7137.5  .00004   F
10350.  .00003
25-Oct-2001 08:53:39   FAILED  Ch 02   F  1231.3  .00018   F  4318.8  .00005   F  9987.5  .00004   F
10794.  .00004
25-Oct-2001 08:53:44   FAILED  Ch 02   F  1131.3  .00019   F  4481.3  .00006   F  8987.5  .00004   F
10119.  .00003
25-Oct-2001 08:53:48   FAILED  Ch 02   F  1231.3  .00018   F  4981.3  .00006   F  7381.3  .00005   F
10756.  .00005
25-Oct-2001 08:53:52   FAILED  Ch 02   F  1131.3  .00018  P   5550.0  .00005   F  7493.8  .00004  P
11644.  .00003
25-Oct-2001 08:53:54   FAILED  Ch 02   F  1231.3  .00018   F  4381.3  .00006   F  7043.8  .00004   F
12156.  .00004
25-Oct-2001 08:54:04   FAILED  Ch 02   F  1231.3  .00018   F  4718.8  .00005   F  7018.8  .00005   F
11094.  .00004
25-Oct-2001 08:54:06   FAILED  Ch 02   F  1231.3  .00017   F  4306.3  .00004   F  7350.0  .00004   F
11094.  .00004
25-Oct-2001 08:54:18   FAILED  Ch 02   F  1231.3  .00017   F  4381.3  .00006   F  9600.0  .00004   F
9987.5  .00003
25-Oct-2001 08:54:20   FAILED  Ch 02   F  1231.3  .00017   F  4381.3  .00006   F  7112.5  .00004   F
12006.  .00003

TOTAL PASSED:        0         Ch 02  0                   2                   1                   2
AVERAGE PASSED:        0.00%   Ch 02        0.00    0.00      5400.0  .00005      8243.8  .00005
11509.  .00003
STD DEV PASSED:                Ch 02        0.00    0.00      150.00  11.1E-07        0.00    0.00
134.38  25.6E-07

TOTAL FAILED:        20        Ch 02  20                  18                  19                  18
AVERAGE FAILED:      100.00%   Ch 02      1220.9  .00018      4443.8  .00006      8080.9  .00004
10893.  .00004
STD DEV FAILED:                Ch 02      107.91  .00001      273.87  59.9E-07      935.71  35.7E-07
727.93  45.1E-07

TOTAL:               20        Ch 02  20                  20                  20                  20
AVERAGE TOTAL:       100%      Ch 02      1220.9  .00018      4539.4  .00005      8089.1  .00004
10955.  .00004
STD DEV TOTAL:                 Ch 02      107.91  .00001      389.94  62.0E-07      912.71  35.7E-07
716.14  43.8E-07

eZ-NDT/RI Detailed Report
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Plot Data…
The Plot Data report generates a list of all the data points (using x and y coordinates) that are displayed on
the graph. To generate a Plot Data report:

1. Select Plot Data... on the Report menu.

2. A save file dialog box will open.

3. Type a name your report file in the filename data entry box. Use a unique name for each report.

4. Click the Save button.
After generating the report, eZ-NDT/RI automatically opens the text file in Windows NotePad or WordPad.

Configuration...
The Configuration Report is a comprehensive listing of the project’s parameters.  It is a text file that can be
saved and included with project documentation.

1. Select Configuration Settings... on the Report menu.

2. A save dialog will open.

3. Type a name your report file in the filename data entry box. Use a unique name for each report.

4. Click the Save button.

After it is generated, eZ-NDT/RI will automatically open the report using Windows NotePad or WordPad.
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User Menu

Enter Password
Enter a Password for Level 3 (Manager).  This password allows you to “password protect” your NDT/RI
project.

Enter Password Dialog

Change Password

Edit Password Dialog

Change User Levels

Remember your Level 3 password.  If you go to Level 1 (Inspector), you will need the
password to return to Level 3 (Manager).

The current User Level is displayed in the lower portion of the Acquisition panel.  There are 3 User Levels.
Level 3 (Manager) allows you complete access to all eZ-NDT/RI features.  Level 1 (Inspector) enables
minimal features.  Typically you would use this feature if you have concerns regarding unauthorized access
to your eZ-NDT/RI Projects while the system is unattended.  Use the User pull down menu to modify the
security access level and Level 3 password.

Help Menu

What’s This Help
When you use this menu item, your cursor changes to a question mark, “?.”  Click on an eZ-NDT/RI panel
or screen with this cursor for a brief explanation of the selected item.

About
This menu item tells you the version of eZ-NDT/RI you are running, and your system configuration.
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Additional Notes
Here is a list of common suggestions for you to use eZ-NDT/RI more effectively.

1. It will save you time, if you modify the NDT/RI project in the executable’s directory to match your
standard configuration.  Whenever you create a New Project, this project is the configuration
template that is copied into your new project.

2. Make sure your ZonicBook Dip Switches are configured correctly.
(Typically:  Single Ended, AC coupled, and ICP ON.)

3. Use a standard channel location convention for your Force and Response channels.
(Typically:  Force is channel 1 and Response is channel 2.)

4. If you aren’t getting a Trigger after you strike the part, verify the Force channel’s FSV and
Trigger Level Percentage.

5. A negative Pre / Post Trigger percentage will result in FRF calculations and limit checking.  A
positive Pre / Post Trigger percentage will use auto spectrum.  Generally, you should use a positive
Pre / Post Trigger percentage.

6. Some older versions of eZ-NDT/RI created multiple project files (i.e., files with extensions “.ndt1”,
“.ndt2”, etc.). If you wish to open an older file with newer versions of eZ-NDT/RI which use only
one file, simply open the old “.ndt1” file. This old project will automatically be converted to a single
file with a “.ndt” extension.

7. If for some reason, you have an error where eZ-NDT/RI does not start.  You can work around
the problem by deleting the file, “ndt.ini,” located in the executable’s directory.  This file identifies
the last Project opened.  You can delete this file without affecting your data.  Try reopening the last
project.

8. If you still experience problems.  Please send an email to productsupport@iotech.com.

mailto:productSupport@iotech.com
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 Setting Limits 5
Limits are defined frequency and amplitude ranges (where the resonances of a part will peak) across the
x-axis.  In our example, we impacted several known good parts and captured a sample resonance in the
following display.  We then placed cursors at the peaks we thought were significant.  These same peaks
may change in amplitude or shift frequency if a part is bad.  Please note that significant peaks are not
always the ones with the most amplitude.  In fact, some of the peaks at lower amplitudes can be very
significant because when they are below a certain amplitude it indicates that the part is “bad.”

Significant Peaks

Now that we know where the peaks are located, we can set the limit range in which they will appear.

Use the cursor values listed to the right of the plot to help you determine where frequency and
limit ranges should be set.

Note that the first cursor is at 4250 and that there is another peak at approximately 4800, which we did not
mark with a cursor.  However, if a part is bad, that peak may shift down in frequency.  Therefore, when
setting our “good” limit, we must make sure that we set it low enough so that the resonance shift of the
“bad” peak doesn’t create a peak within our “good” limits.

In our example we set the frequency range from 4050 to 4450 and the frequency limits between 4150 and
4350.  Remember our “good” peak should be around 4250.

Setting Limits using Significant Peaks
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Introduction 1

What is eZ-Balance? …… 1
Overview of the Balance Job …… 1
Connecting The ZonicBook for Online Acquisition …… 2
Balance Job Check List …… 2

Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

What is eZ-Balance?
eZ-Balance is a multi-plane balance software package, that will compute the optimal balance weights and
locations based on vibration data.  This data can either be collected by the ZonicBook FFT Analyzer or
entered manually.  You can configure eZ-Balance to have from 1 to 7 balance planes.

The setup includes 1 tach input channel and from 1 to 7 response channels. Accelerometer, Velocity, and
Displacement probes are examples of Response Channels.

You can interactively review the vibration data and balance results in graphical format.  A balance toolkit is
provided for typical balance calculations, such as splitting weights.

Overview of the Balance Job
Each balance “job” in eZ-Balance is unique.

For example, if you have 2 motor driven fans, 201 and 202, you have 2 separate eZ-Balance Jobs, one for
each machine.

Each eZ-Balance Job has its own set of configuration and data files that can be stored and later retrieved.

Each time you create a new eZ-Balance Job, the Job Template configuration is copied to the new
eZ-Balance Job.  The defaults are suitable for most balance jobs.

After you have configured your eZ-Balance Job, you are ready to begin the Balancing Process.  You need
to collect vibration data at several machine conditions (runs).  These runs include the initial run, the trial
run(s), and the optional trim run.  The initial run is the machine’s condition prior to any balance efforts.
The trial run(s) measure the vibration effect of adding trial weights to the balance plane.  Lastly, the
optional trim run measures the final result of your balance efforts.  The number of trial runs is equal to the
number of balance planes.

Vibration data is the vibration amplitude and phase measured at the machine’s running speed (frequency).
These values are commonly referred to as the first order amplitude and phase.  The vibration data can be
either automatically measured using the ZonicBook FFT Analyzer or entered manually using the keyboard.
Enter the trial weight and location values prior to each trial run.

The Control window identifies where you are in the balance process.  After the trial runs have been
completed, you then request eZ-Balance to compute a balance solution.
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Connecting The ZonicBook for Online Acquisition
Reference Note:
If necessary, refer to the ZonicBook Getting Started User’s Manual for information
regarding the following:

➣ Software Installation

➣ System Requirements

➣ Hardware Setup

➣ Driver Installation

If you are using the ZonicBook Analyzer to capture data for your balance job, connect your analog input
signals to the ZonicBook’s BNC inputs.  Configure the Dip Switches as needed.  Typically, proximity and
DC proportional signals should be DC coupled; and Accelerometer, Velocity, and Tach signals should be
AC coupled.

Proximity: SE(single ended) DC ICP off
Accelerometer/*Velocity: SE AC ICP  on
Tach: SE AC ICP off

*Velocity can be either ICP on/off depending on the instrument being used.

Balance Job Check List
Determine method for using eZ-Balance (online with a ZonicBook or offline).
If online, start the ZonicBook, verifying all connections and hardware settings.

1. Start eZ-Balance.
2. Create a New eZ-Balance File, or Open a previously saved one using the File Menu options.
3. If you are working online, modify the ZonicBook Configuration via the Edit Menu.
4. Acquire Vibration Data using the ZonicBook or Enter Data Manually for the Initial Run.
5. Add balance weight.
6. Acquire Vibration Data using the ZonicBook or Enter Data Manually for the Trial Run.
7. Repeat Steps 6 and 7 for each plane.
8. Calculate a solution.
9. Add Solution Weights to Balance Plane
10. Acquire Trim Run Vibration Data
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1. Start eZ-Balance
To run eZ-Balance, double-click the eZ-Balance icon or use your Windows desktop Start button to navigate
to the program file.

The first time you run eZ-Balance, the Registration Form will open.  You must enter this information for
eZ-Balance to operate.

The Password accompanies the CD-ROM  or in an email if you downloaded eZ-Balance from the Web
Site.  You will not have to re-enter this information again, unless you upgrade to a newer version, or if you
reinstall eZ-Balance.

Registration Form
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After you click OK on the Registration Form the eZ-Balance Main window open.
This window contains a set of windows you will use interactively during your balancing project.

Main Window

2.  Create a New Job
1. On the File Menu, select New eZ-Balance File to open the Save As dialog window.

Save As Dialog

Select or create a folder for your eZ-Balance Project.

We recommend you store all jobs in a separate “Jobs” folder.  This allows for easier file
maintenance.

2. Enter the name for the eZ-Balance Project.
3. Click the <Save> button to create the new project.
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The first time eZ-Balance runs, it automatically loads the default configuration parameters into a
“Job Template.”  This information is located in the Windows directory where you installed eZ-Balance.
Each “eZ-Balance Job” has its own file with the .ezb extension.

3.  Modifying the ZonicBook Setup for On-line Balancing
After you create a new eZ-Balance Job, you need to verify that the default setup is valid for your job.  For
many jobs there is no need to modify the default setup.  To modify the Acquisition and Input Channels
parameters, select ZonicBook on the Edit menu.

These menu options are not available if Data Acquisition is on.

ZonicBook Setup Acquisition Tab
Use this panel to configure the ZonicBook’s Acquisition parameters for your eZ-Balance Job.  If you make
any changes, click the <Save> button.

Balance Configuration   Acquisition Tab
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ZonicBook Setup Channels Tab
Use this panel to configure each channel for your balance job.  Select a channel then set the values for each
attribute.  Repeat for each channel.  [Defaults:  Channel 1 is the Tach, Channel 2 is the Accelerometer.
Channels 3 through 8 are unused (not set up).

Balance Configuration   Input Channels Tab

4.  Input Initial Vibration Data
Balance Data can be acquired with the ZonicBook analyzer (on-line), or it can be entered manually (off-line).

Control Window
Use the Control window to keep track of the balance project’s tasks.   After each step is completed an asterisk is shown
next to the step number.

Control Window

Vibration data acquired
or manually entered
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Polar Display
Note: The data in the graphics are for presentation only and do not represent a real balancing

project.

On-line
Before acquiring vibration data, verify that your ZonicBook is properly connected and
configured.  See the ZonicBook Getting Started manual.

Polar Display Window
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Press the Toggle Switch   in the Analyzer panel to enable data acquisition.

The Polar Display window displays the measured Speed, Overall, 1x Amp, and 1x Phase values.

Polar Display Table

After the machinery reaches a steady state, press      .  This logs the vibration data for the current Run.

Off-line
Enter your data into the Vibration Data window.

After entering the vibration data for the initial run, press, .

Control Window
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5.  Add Balance Weights
View the plotted vibration data and determine where you may need to add balance weights.  Add the
weight to your machinery.  In the Balance Weights window enter the trial weight amount and the angle
used.  Notice how the arrow in the Angle Dial has changed.

    Balance Weights Window

6. Input Data for Trial Run Balancing

Control Window
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Use the same method you used in Step 4 to enter Trial Run Vibration data.  Repeat Steps 5 and 6 for each
Balance Plane.  After each step is completed an “*” is shown next to the step number.

Control Window

7.  Calculate a Solution
Click the Calc Balance Solution button, .

Note that you now have several pieces of information displayed in the Balance Weights window.  In the
Solution area you have the weight and location to place the final correction.  You also have the influence
coefficients.  Under the table of weights and angles you also have the effective weight and angle.

You can see that another arrow (green) has been added to the Angle Dial.

You can now choose to use a Solution with (Keep) or without (Remove) the weight you added.  Select the
radio button of a solution choice to see the values.

Balance Weights
Keep Trial Weights

Balance Weights
Remove Trial Weights
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8.  Add Solution Weights to the Balance Plane
At this time you know how much weight to add and the location.  If you can’t implement the solution as
given.  Click the       button to open the toolbox for assistance in various calculations you may need to
complete your balancing project.

9.  Acquire Trim Run Vibration Data
The Trim run verifies the Balance solution.  To fine-tune the results, repeat the process.
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Windows and Menus 3

The Main Window …… 13
Task Bar …… 14
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Save Runout Compensation Button …… 14
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Show Control Window …… 34
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Tile Vertical …… 35

Tips and Tricks …… 36

The Main Window
The Main window is comprised of menus, buttons, and windows needed to complete a balancing project.
This chapter covers the menus and windows used in eZ-Balance.

First the windows and icons will be explained followed by the Menu system.

Main Window



eZ-Balance, pg. 14 10-30-01 ZonicBook

Task Bar

Task Bar

ZonicBook On/Off  Switch          /
Click the On / Off  toggle switch to start and stop data acquisition.

• On  = up green toggle switch,       .
• Off = down red toggle,        .

Pause/Continue Button        /
Click the < Pause / Continue > button to temporarily halt data acquisition.

• Red = Paused
• Green = Continued

Snapshot Button
Click the < Snapshot > button to save the current acquisition data to the History file.  The History file is
FIFO (first in first out).  The number of records in the file is set in the acquisition tab of the ZonicBook
Configuration window.

Save Runout Compensation Button
Click the < Save Runout Compensation > button to save very low speed (ie. 50 to 200 rpm) data.  The
purpose of this file is to capture vibrations due to mechanical or electrical defects that are inherent in the
structure (i.e. shaft).

Apply Runout Compensation Button
Click the < Apply Runout Compensation > button when your machinery is running at full speed.

Add Vibration Plot Window
Click the < Add Vibration Plot Window > button to open a plot window that contains vibration data from
a response input channel.

Add Balance Weights Window
Click the < Add Balance Weights Window > button to open a balance plane window.  This window is
used to enter the trial weight for each Balance plane.

Show Comments Window
Click the < Show Comments Window > button to open the Comments window.  There is space for five
dated comments in this window.

Show Machine Graphics Window
Click the < Show Machine Graphics Window > button to open the Machine Picture window.
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Balance Toolkit
Click the < Balance Toolkit  > button to open the Balance Toolkit window.  The Balance Toolkit contains
utilities for balancing calculations.

Analyzer Status
The adjacent area on the Task Bar displays the status of the ZonicBook analyzer.

Control Window

Control Window

The Control Window controls the balancing project and acts as a visual aid, tracking the project.  The six
basic steps to complete a balancing project are listed vertically.
(Note:  For mutliplane balancing there are more steps.)

1. The Initial Run data is collected from your unbalanced machine.  Enter the vibration data in the data
cells or use the ZonicBook to capture data on-line.

2. Trial Weights are needed to calculate a balance solution.  Enter the trial weight(s) and location(s) in
the data cells provided in the Balance Weights window.

3. After the trial weights have been physically added to the machine, run the machine again until it
reaches a steady-state; then capture Trial Run 1 data.

4. eZ-Balance now has enough information to Calculate a Solution.
5. Physically add the Solution Weights to the Balance Planes.
6. To verify your solution perform a Trim Run.

Use the control buttons,                           ,  to move through the steps.

Click the Clear All Data button,       , to clear all the response data collected for this job.

Click the Clear Last Run button,      , to delete the last run when you do not want to accept the data from
that run.  This resets the balance job status to the previous run.

Click the Accept Data button,     , when the machinery has reached a steady-state and has collected data
on-line.  This stores the data for the current run.

You can also manually enter the vibration data for each Run.  Click on the desired cell in the table at the
top of the Polar Display window and enter the vibration data.  Press Enter to move down to the next cell.

Click the Begin Next Run button,      , after you have added trial weights to move to the next run.

Click the Solution button,       , to calculate a balance solution.  The correction weights and angles needed
for each balance plane are displayed in the Balance Weights window.
The projected response, after all corrections have been made, is displayed in the Polar Display window.

By default, eZ-Balance includes the trial weights in the balance solution.  You can optionally calculate a
balance solution without the trial weights by selecting the < Remove > radio button.

Click the Add Solution Weights to all Balance Planes button,       , to have eZ-Balance add the solution
weights to the Balance Weights window prior to performing a Trim  Run.
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Vibration Data Display Window

Vibration Data Display Window

The channel buttons                                                 are set up in the ZonicBook Configuration window;
which is accessed via the Edit menu.  The blue and white buttons indicate active response channels.  The
blue button is the channel being displayed.

The Plot button controls the plot display type. Click this button to toggle through the following choices:

Polar Plot
Time Plot
Spectrum Plot

The Scale button controls the plot scale type.  Click this button to toggle through the following choices:   

Auto Scale
Instrument Scale
User Scale

The Format button controls Linear,        and Log,       for spectrum displays.  Click this button to toggle
between the two formats.

Vibration Data Table

The above table contains the vibration data for each balance run.  The data can be entered manually,
or collected on-line by the ZonicBook FFT Analyzer.

The data in the table is displayed in the Polar plot.

Polar Plot
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Balance Weights Window

Balance Weights Window

Each of the buttons at the top of the window represent a Balance plane.  The Blue and White Buttons are
the planes to be balanced.  The Blue button is the selected plane.

Any Location allows you to place weights at any angle.

Fixed Location will insert a list of locations in the table.  When Fixed Location is selected, you have the
option to select the Start Angle and the Number of Locations.

The table shows the amount of Weight added at a specific Angle.

Engineering Units are not listed in this window.   It is up to the user to keep consistent units.

A Red Line in the dial indicates the location of an added weight.

The Blue Arrow in the dial indicates the location of the effective weight.

The Green Arrow in the dial indicates the location of the Final solution.

Select Remove to see the solution without the trial weight, select Keep to see the solution with the trial
weight.

In the Balance Solution area the Weight / Location of the solution is displayed followed by the
Influence Coefficients.

Below the table the Effective Weight and Location of the solution is listed.

Click        to Clear All Weight from the table.
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File Menu

New eZ-Balance File
Select this menu item to create a new file for your new balance job.

Save As Dialog

Open eZ-Balance File
Select this menu item to open an existing file for your balance job.

Open eZ-Balance File Dialog

Save eZ-Balance File
The Save eZ-Balance File option saves the current state of the project.

Save Snapshot
The Save Snapshot option  saves the current record and stores it in the history file.

Save Runout
The Save Runout option saves the Runout data to file.

Print Screen
The Print Screen menu option opens the Print dialog box for your default printer.

Exit
The Exit menu option closes eZ-Balance.
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Edit Menu

ZonicBook…
When you select ZonicBook on the Edit menu, the ZonicBook Configuration window opens.  This window
has two tabs.  Use the Acquisition Tab to set up the acquisition parameters.  Use the Input Channels Tab to
set the tach and input channels.

Acquisition Tab
Use this panel to configure the ZonicBook’s Acquisition parameters for your eZ-Balance Job

Balance Configuration Acquisition Tab

Block Size: This value is the number of samples per block of data.  For example, a 2048
Block size contains 2048 data samples and will produce an 800 line spectrum.
A larger Block size will provide you with greater data resolution, however, the
larger the Block size, the longer it takes to collect the data.

Analysis Frequency: This value is the maximum frequency of interest.  The sampling rate will be
2.56 times the analysis frequency.  Verify the maximum frequency response of
your probes.  Typically, the analysis frequency will be 500 to 2000 KHz.
If you have a Tach signal, your Analysis Frequency should be a higher multiple
of the maximum rotating speed. Typically, this multiple is at least 10 times the
rotating frequency.

Number of averages: The averaging function is a rolling buffer that averages the last “n” data blocks.
FFT Window: Options are None, Hanning, Flat Top, or Blackman Harris.  Hanning provides

better frequency resolution.  Flat Top provides better amplitude resolution.
No. Balance Planes: eZ-Balance can have between 1 and 7 balance planes.
ZonicBook Input
Module:

Allows the selection of either an 8-Channel or 16-Channel ZonicBook. If a 16-
Channel ZonicBook is selected, only the first 8 channels can be used to acquire
data.

Low Frequency
Cutoff for Single and
Double Integration:

Low frequency cutoff is used to remove the low frequency effects of integration.
All spectral amplitude values below the specified frequency value are set to
zero.
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Input Channels Tab
Use this window to configure each ZonicBook input signal for your eZ-Balance Job.  For each desired
channel set the values for each attribute.

Balance Configuration Input Channels Tab

Type: This is the type of instrument that will be connected to the selected channel. Instrument Types
include Accelerometer, Velocity, X probe, Y probe, Z probe, and Tach.  Make your selection on
the pull down menu.  If no instrument will be connected to this channel select “unused.”
You must have 1 Tach Channel and 1 or more Response Channels.

For each probe configure the Dip Switches on the ZonicBook Input Module for the
appropriate channel.
Most accelerometers are Single Ended, AC Coupled, and ICP On.  Also, verify the
power source for your transducers.
Refer to the ZonicBook Getting Started User’s Manual

 Name: Enter a name, or label, for the selected channel.
Min and Max: Enter the instrument Range:  Minimum and Maximum in engineering units.
Units: Select the engineering Units on the pull down menu.

The available selections are based on the Instrument Type you selected.
Full Scale Voltage: Select the maximum Full Scale Voltage expected for the instrument.

Erroneous results will occur if you select a voltage value that is less than the actual
input voltage.  If you are unsure of the instrument’s maximum voltage value,
select a high voltage value.  (i.e.: 20V)

mV/EU: This is the instrument’s input Sensitivity.  Typical accelerometers have a
sensitivity of 100 mV per g; and displacement probes have 200 mV per mil.
For Tach probes enter 1000 mV per Volt.

Integration: Accelerometer and Velocity signals can be integrated. Select the desired
“integration” value. If the signal is acceleration, then single integration results in
velocity, and double integration results in displacement.  If the signal is velocity,
then single integration results in displacement.

Int/Units: Select the engineering units to be used after integration from the pull down menu.
Angle: This is the physical angular location of a probe.

Zero degrees is defined to be TDC (+y-axis). The angle value is measured in the
counterclockwise (CCW) direction.  Typically viewed from the driver end.
For example, if your proximity probe is located at the 10 o'clock position
(45 degrees) of the bearing housing, the Instrument Angle is 90 degrees.
Instrument angle is used for data display correction.

Gap Volt: The DC gap voltage reference value when the shaft is at rest.  DC coupling must
be enabled to measure the DC voltage value.
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1xARef and
1xPRef:   

The 1x (first order) Amplitude and Phase values are used for
Runout Compensation on Bode or Polar displays.  These values are commonly
known as Slow Roll Compensation values and should be collected during machine
slow roll conditions (i.e.: Speeds < 500 rpm).  The values must be between the
Maximum and Minimum EU range.

For Tach Probes, you will need to enter the following information:

Rotation: Select the machine’s Rotation Direction, either CCW (counter-clockwise) or
CW (clockwise) on the pull down menu.  The rotation direction is typically
viewed from the driver end.  Rotation direction is used for data display correction.

Trig/Rev: Enter the number of tach trigger pulses per shaft revolution.  This number must
be 1 for all Balance Jobs.  Phase can not be calculated if the number of trigger
pulses is greater than 1.

Trig Dir: Select the tach’s trigger pulse direction, either Neg(ative) or Pos(itive) on the
pull down menu.  Typically this is the direction of the tach signal’s leading edge.
Trigger voltage and direction define the start of a shaft rotation.
A keyway will generate a Negative Tach pulse.

Trig Volt: The tach’s Trigger Voltage number must be less than the tach’s FSV.  A tach
pulse is recognized when the tach signal exceeds the trigger voltage in the trigger
direction specified.  Trigger voltage and direction define the start of a shaft
rotation.  Typical Tach signals will generate at least a 1 V pulse.

Input Channel Tab - Edit Menu
Set Defaults: Sets instrument’s attributes to the default values, based on the defined instrument

type.
Copy Channel: Copies the channel attributes of the channel where the cursor is currently residing.
Paste Channel: Pastes the copied channel attributes to the channel where the cursor is currently

residing.
Fill Down: Copies the channel attributes of the channel where the cursor is currently residing

and copies them to all succeeding channels that are not marked “unused.”
Fill Up: Copies the channel attributes of the channel where the cursor is currently residing

and copies them to all preceding channels that are not marked “unused.”

Load Machine Graphic
The Load Machine Graphic menu option allows you to insert a .jpg or .bmp file in the Machine Picture
window.

Use standard Microsoft Windows techniques to find your Machine graphic.

Load Machine Graphic Dialog Machine Graphic Panel
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Remove Machine Graphic
Select the Remove Machine Graphic to delete the machine picture from the Machine Picture window.

Balance Toolkit
The Toolkit provides a variety of useful balance calculations.  Select the Balance Toolkit option or press
the < Toolkit > button,          , located to the left of the plot, to activate the Toolkit.

There are 10 Tabs in the Toolkit.  Each Tab accesses a specific balance calculation.  Click on the desired
Tab to bring it to the foreground.  Throughout the Tabs, you have the option to work in English or Metric
Units.  The selection of English or Metric units applies to all Tabs.

Trial Wt Calc Tab

Trial Wt Calc Tab

This panel calculates the weight needed to generate a force equal to 10% of the rotor weight given the
rotor radius, weight, and rpm’s.

Find Trial Weight

Enter the rotor radius, weight, and rpm’s.

If the rotor is near resonance, a force equal to 10% of the rotor will have too large of an
effect.  If there is past sensitivity data available, it should be used.
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Split Weights Tab

Split Weights Tab

Find Split Weights

Sometimes you need to add a weight at a specific angular location, but there is no place to physically
mount the weight.  This panel calculates the amount of weight to install at alternate locations, so that the
effect will be equivalent to the original amount of weight required by your calculations.

Spread Angle Method

Enter the amount of weight to be added, the angle closest to the original angular position required by your
calculations, and the spread angle.

Upper/Lower Angles Method

Enter the amount of weight to be added, the desired effect angle that was derived in your original
calculations, the upper angle, and the lower angle.
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Resolving Weights Tab

Resolving Weights Tab

This panel calculates the effect of placing multiple weights at multiple locations.

Enter the weight and angular position (in degrees) of each balancing weight.

A graphical representation of the data entered is displayed to the left with blue circles.
The resultant is displayed as a red circle.  The resultant weight and angle are displayed below the clear
and Clear Last buttons.

Chord-Angle Arc Tab

Chord-Angle Arc Tab

This panel calculates the Chord, Angle, or Arc when the radius and one of three variables is known.

You are prompted to enter the radius and the value of the known variable.  For example, if you select
“Angle” from the “Given” menu and "Chord" from the "Find" menu, you will be prompted to enter the
radius and angle.  The Chord value is then displayed in the lower right section.
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Runout Subtract Tab

Runout Subtract Tab

Find Compensated Amplitude and Phase

This panel vectorially subtracts the runout measured at low speed from the runout measured at balancing
speed.  Runout must be compensated for prior to balancing.

This calculation can also be used to determine the actual amount of vibration that is present in the system.

Enter the amplitude and phase for balancing speed (V1) and slow roll (V2).

Compensated amplitude and phase (V3) are calculated after each data entry.
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Centrifugal Force Tab

Centrifugal Force Tab

Find Force

This panel calculates the centrifugal force generated by a weight.  This calculation can be used to determine
the expected amount of motion if the radius, unbalance amount, and dynamic stiffness of the structure are
known.

Enter the amount of weight added in ounces or grams, the radius (distance from the center to weight), and
the rotor rpm.
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Unbalance Tolerance Tab

Unbalance Tolerance Tab

This panel calculates the acceptable amount of residual unbalance.

Selecting the Balance Grade

This menu allows you to select from a list of ISO balance grade standards.

When a balance grade is selected, an example of equipment normally associated with the selected grade is
displayed.  Select the appropriate balance grade to calculate the acceptable amount of residual unbalance
that will allow a rotor to fall within the ISO balance grade criteria.

Find Unbalance Tolerance

Enter rotor weight and speed.

The Upper Limit for rigid frames and the Lower Limit for flexible frames is displayed at the bottom of the
window.



eZ-Balance, pg. 28 10-30-01 ZonicBook

Stock Weights Tab

Stock Weights Tab

Selecting the Stock

This menu allows you to select the stock type. Select flat or round.  Note that the graphic below changes
based on your selection.

Find Weight of Stock

This panel calculates stock weight given the length, width/diameter, and thickness of a specified material.
Enter the stock length, width/diameter, and thickness/diameter.

Find Length of Stock

This panel calculates stock length given the weight, width/diameter, and thickness of a specified material.
Enter the stock weight, width/diameter, and thickness/diameter.
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Drill Bit Weight Tab

Drill Bit Weight Tab

Find Weight

This panel calculates the weight removed by a drill bit for various materials given a specified drill bit
diameter and depth.

Enter the Drill Bit Diameter and the Drill Depth.

Selecting the Material

This menu allows you to select from a list of various materials.

Find Depth

This panel calculates the drill depth needed to remove a specified amount of weight for various materials.

Enter the Drill Bit Diameter and the Weight Removed.
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Arc Weight Tab

Arc Weight Tab

Effect of Weight Added

This panel calculates the effect of weight added over an arc.

Enter the arc length, weight added, and arc radius.

Find Desired Effect

This panel calculates the weight needed to cause a desired effect.

Enter the desired weight effect, weight radius, and weight per unit length
(desired weight divided by arc length).

Copy Display Window
The Copy Display Window option copy the Main window with all its sub-windows to the clip board.  It can
then be pasted into other report applications, such as Microsoft Word.
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Report Menu

Balance Results
The Balance Results menu option opens the Save As Menu.  Type a name for your report and click the
Save button.  A text file of your results is created and saved.  The report can be opened with
Microsoft Word or Notepad.

Save As Balance Result Report Balance Result Report
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Balance Configuration
The Balance Configuration menu option opens the Save As Menu.  Type a name for your report and click
the Save button.  A text file of your configuration is created and saved.

Save As Balance
Configuration Report

Balance Configuration Report

Acquisition Menu

Start / Stop Acquisition
You can start and stop acquisition with this menu option or with the On/Off toggle switch       /            in the
Main window.

Pause / Continue ACQ
You can pause and continue data display with this menu option or with the Pause/Continue toggle
button        /        in the Main window.

Control Menu

Clear All Runs
The Clear All Runs menu option deletes all the vibration data from the Polar Display window.
 You can also click the       to clear all runs.

Clear Current Run
The Clear Current Run menu option deletes the current (last entered) vibration data from the Polar Display
window. You can also click       to clear the last run.
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Save Current Run
Use this menu option to save the current (last) run.

Begin Next Run
Use this menu option to start the next run.

Calc Balance Solution
This menu item calculates the balance solution and displays the information in the Balance Weights
window.  You can also click       .

Add Sol Wts to Bal Plane
This menu item adds Solution Weights to the Balance Weights window.

Window Menu

Add Vib Plot Window
This menu item opens a Polar Display window each time it is selected.

Polar Display Window
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Add Bal Weights Window

Balance Weight Window

This menu item opens a Balance Weight window each time it is selected.

Show Control Window
This menu item opens the Show Control window.

Control Window
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Show Machine Graphic
This menu item open the Machine Picture window.

Machine Graphic Window

Show Comments
This menu item opens the Comments window.

Comments Window

Cascade
This menu item places multiple plot windows (starting from the upper left corner of the screen) slightly
down and to the right of the prior window.

Tile Horizontal
This menu item Tiles multiple plot windows across the screen.

Tile Vertical
This menu item tiles multiple plot window from the top to the bottom of the screen.
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Tips and Tricks
Here is a list of common suggestions for you to use eZ-Balance more effectively.

1. It will save time, if you modify the eZ-Balance Job in the executable’s directory to match your
standard configuration.  This is the Job Template.  Whenever you create a New Job, the Job
Template is copied into your new Job.

2. Make sure your ZonicBook Dip Switches are configured correctly.
3. Use a standard channel location convention for your Tach and Response channels.  (Typically:  Tach

is channel 1 and Response channels are 2 through 8.)
4. If you aren’t getting a Tach Trigger, verify the Tach channel’s FSV and Trigger Level Percentage

and Direction.
5. If for some reason, you have an error where eZ-Balance does not boot up.  You can delete the file,

“EZBal.ini”, located in the executable’s directory.  This file identifies the last Job opened.  You can
delete this file without affecting your data.  Try reopening the last Job.

6.  If you still experience problems.  You can send an e-mail to productsupport@iotech.com .

mailto:productSupport@iotech.com

	ZonicBook Systems Manual
	Document Contents
	ZonicBook Getting Started
	Introduction
	ZonicBook Hardware
	ZonicBook Software

	System Requirements
	Software Installation
	Software Installation for Windows 98/Me/2000/XP/NT
	A Special Note for Windows NT Users
	Hardware Setup and DSP-Card Installation    (All Windows Systems)
	Verifying DSP-Card Installation

	Hardware Setup
	Configuring Channels via DIP-Switches
	Connecting and Powering a ZonicBook System

	Starting the ZonicBook
	ZonicBook Specifications

	eZ-TOMAS User's Manual
	Table of Contents
	Chapter 1 - Introduction
	What is eZ-TOMAS
	Start eZ-TOMAS
	Connecting Signals
	Order of Operation

	Chapter 2 - Start a New Project
	Configure the Project
	Configure the ZonicBook

	Start Monitoring
	View Spectral Bands
	Plot Data
	Multiple Plots

	Generate Limits
	Limit Status Color Code

	Continue Monitoring
	Are Alarms Acceptable?

	Chapter 3 - Windows and Menus
	Main Window
	Main Menu
	Instrument Gauges
	Control Panel
	Data Storage Panel
	Relays Panel
	Tach Reference Panel
	Security Level Panel
	Network Panel
	Machine Description Panel


	The Menu System
	File Menu
	New Project
	Open Project
	Save As
	Overlap Data
	Erase History File
	Print
	Exit

	Edit Menu
	ZonicBook Configuration Window
	Acquisition Configuration Tab
	Channels Configuration Tab
	Spectral Bands Tab
	Storage Tab

	Limits
	Limit Status Color Code

	Relay Outputs
	Communication Panel
	Relay Output Panel
	Network
	Copy Window
	Load Graphic Picture
	Remove Graphic Picture

	View Menu
	Plots Menu
	Data Display Window
	Display formats
	Recall Preferred Plot Setup
	Data Source
	Formatting Options
	Filtering Data
	Examples of Displays
	Time Display
	Spectrum Displays
	Bode Displays
	Orbit Displays
	Polar Displays
	Strip Chart Displays
	Waterfall Displays


	Reports Menu
	Statistical Report
	Generate Limits

	Alarm Log Report

	ZonicBook Configuration
	Security Menu
	Change Password

	Glossary
	Additional Notes


	Chapter 4 - Program Function Keys
	Customize tomasfkeys.ini file


	eZ-NDT/RI User's Manual
	Warranty Information
	Warnings, Cautions, Notes, and Tips
	Table of Contents
	Chapter 1 - Introduction
	What is eZ-NDT/RI
	System Requirements
	Order of Operation

	Chapter 2 - Investigative Mode Testing
	1. Gather known "good" and "bad" parts
	2. Set up the analyzer, hammer, microphone, and computer
	3. Launch eZ-NDT/RI
	First Time Running eZ-NDT

	4. Open a new eZ-NDT/RI project
	5. Select Investigation mode
	6. Configure the ZonicBook
	7. Select plot display type
	8. Turn on data acquisition
	9. Test all good parts
	10. Test all bad parts
	11. Compare the results of good and bad tests
	12. Configure the limits
	13. Verifying the limits and ranges

	Chapter 3 - Q/A Mode Testing
	1. Launch eZ-NDT/RI
	2. Open the eZ-NDT/RI Project
	3. Turn on Analyzer
	4. Test Parts
	Reviewing NDT/RI Inspection Results
	Preparing Reports

	Chapter 4 - Windows and Menus Section
	Main Window
	Acquisition Panel
	Relay Output Panel
	Display Panel
	Status Panel
	Summary Panel

	Graphical Display
	Limit Range
	Modifying Limits From the Main Window
	Magnifying Areas on Graph

	File Menu
	New Project
	Open Project
	Save Project
	Save As...
	Start/Stop Acquisition
	Erase History File
	Print
	Exit

	Edit Menu
	ZonicBook
	Acquisition Tab
	Channels Tab
	Channel Tab- Edit Menu

	Limits Tab
	Limits Tab - Edit Menu

	Automation Tab
	Communication Panel
	Relay Output Panel
	Response Channel State Panel
	Consecutive Panel
	How Automation Relays Work


	Reset Summary Counts
	Copy Window
	Load Graphic Picture
	Remove Graphic Picture

	Report Menu
	Generate a Production Report
	Summary...
	Detailed...
	Plot Data...
	Configuration...

	User Menu
	Enter Password
	Change Password
	Change User Levels

	Help Menu
	What's This Help
	About

	Additional Notes

	Chapter 5 - Setting Limits

	eZ-Balance User's Manual
	Warranty Information
	Warnings, Cautions, Notes, and Tips
	Table of Contents
	Chapter 1 - Introduction
	What is eZ-Balance?
	Overview of the Balance Job
	Connecting the ZonicBook for Online Acquisition
	Balance Job Check List

	Chapter 2 - A Balancing Project
	1. Start eZ-Balance
	2. Create a New Job
	3. Modifying the ZonicBook Setup for On-Line Balancing
	ZonicBook Setup Acquisition Tab
	ZonicBook Setup Channels Tab

	4. Input Initial Vibration Data
	Control Window
	Polar Display
	On-line
	Off-line


	5. Add Balance Weights
	6. Input Data for Trial Run Balancing
	7. Calculate a Solution
	8. Add Solutions Weights to Balance Plane
	9. Acquire Trim Run Vibration Data

	Chapter 3 - Windows and Menus
	The Main Window
	Task Bar
	ZonicBook On/Off Switch
	Pause/Continue Button
	Snapshot Button
	Save Runout Compensation Button
	Apply Runout Compensation Button
	Add Vibration Plot Window
	Add Balance Weights Window
	Show Comments Window
	Show Machine Graphics Window
	Balance Toolkit
	Analyzer Status

	Control Window
	Vibration Data Display Window
	Balance Weights Window
	File Menu
	New eZ-Balance File
	Open eZ-Balance File
	Save eZ-Balance File
	Save Snapshot
	Save Runout
	Print Screen
	Exit

	Edit Menu
	ZonicBook...
	Acquisition Tab
	Input Channels Tab
	Input Channel Tab - Edit Menu


	Load Machine Graphic
	Remove Machine Graphic
	Balance Toolkit
	Trial Wt Calc Tab
	Split Weights Tab
	Resolving Weights Tab
	Chord-Angle Arc Tab
	Runout Subtract Tab
	Centrifugal Force Tab
	Unbalance Tolerance Tab
	Stock Weights Tab
	Drill Bit Weight Tab
	Arc Weight Tab

	Copy Display Window

	Report Menu
	Balance Results
	Balance Configuration

	Acquisition Menu
	Start/Stop Acquisition
	Pause/Continue ACQ

	Control Menu
	Clear All Runs
	Clear Current Run
	Save Current Run
	Begin Next Run
	Calc Balance Solution
	Add Sol Wts to Bal Plane

	Window Menu
	Add Vib Plot Window
	Add Bal Weights Window
	Show Control Window
	Show Machine Graphic
	Show Comments
	Cascade
	Tile Horizontal
	Tile Vertical

	Tips and Tricks



